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PREFACE

The Myanmar Ministry of Education developed the four-year Education College curriculum, 
in line with the pre-service teacher education reform as specified in the ‘National Education 
Strategic Plan’ (NESP) 2016-2021.

The Myanmar Education College curriculum consists of several components: the curriculum 
framework, syllabi, Student Teacher Textbooks, and Teacher Educator Guides. This 
curriculum for the four-year Education College  was designed and structured to align with 
the Basic Education Curriculum and to equip student teachers with the competencies needed 
to teach effectively in Myanmar’s primary and middle school classrooms. It is based on a 
Teacher Competency Standards Framework (TCSF) which articulates the expectations for 
what a teacher should know and be able to do in the classroom.

The curriculum follows a spiral curriculum approach, which means that throughout the four 
years student teachers return to familiar concepts, each time deepening their knowledge and 
understanding. To achieve this, the four-year Education College programme is divided into 
two cycles. The first cycle (Years 1 and 2) is repeated at a deeper level in the second cycle 
(Years 3 and 4) to enable student teachers to return to ideas, experiment with them, and 
share with their peers a wider range of practices in the classroom, with the option to follow 
up on specific aspects of their teaching at a deeper level. 

The curriculum structure provides an integrated approach, where teaching of subject 
knowledge and understanding educational theories are learnt through a supportive learning 
process of relevant preparation and practical application and experience. The focus is, 
therefore, not just on subject content, but also on the skills and attitudes needed to effectively 
apply their knowledge, skills, and attitudes in teaching and learning situations, with specific 
age groups. As the focus is on all components of a ‘competency’ – knowledge, skills, 
attitudes and their effective application – it is referred to as a competency-based curriculum.

Accordingly, a competency-based curriculum is learner-centred and adaptive to the changing 
needs of students, teachers and society. Where new concepts are learnt, they are then applied 
and reflected on: 
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	 1.	 Learn (plan what and how to teach);
	 2.	 Apply (practise teaching and learning behaviours); and 
	 3.	 Reflect (evaluate teaching practice).

Beyond the Education College curriculum, it is intended that student teacher graduates will 
be able to take and apply this cycle of ‘learn, apply and reflect’ to their own teaching to 
effectively facilitate the learning and development of Myanmar’s next generation.

The Myanmar Education College curriculum was developed by a curriculum core team, 
which is a Ministry of Education-appointed team of Myanmar Education College teacher 
educators supported by the Ministry of Education, resource persons from the Universities 
of Education, University for the Development of National Races of the Union and a team of 
national and international experts. Overall guidance of the work was provided by the 
Department of Higher Education, Ministry of Education.

The curriculum development was also supported by the Strengthening Pre-Service Teacher 
Education in Myanmar project, with technical assistance from the United Nations 
Educational, Scientific and Cultural Organization (UNESCO) and financial contributions 
from Australia, Finland, and UK Governments. Substantial input to the drafting process was 
also provided by Japan International Cooperation Agency and the primary education 
curriculum development team through the Project for Curriculum Reform at Primary Level 
of Basic Education (CREATE) team.

Year 1 Semester 1 - EDU1109 - Curriculum and Pedagogy Studies: Information and Communication Technology
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HOW TO USE THIS TEXTBOOK

Who will use this ICT Student Teacher Textbook?

This Student Teacher Textbook has been designed to guide you, as a student teacher, through 
Year 1 of the Information and Communication Technology (ICT) subject. In this Student 
Teacher Textbook, you will find foundational information about ICT. The Student Teacher 
Textbook also includes learning activities and additional resources to help you develop the 
knowledge, skills and attitudes you need to be an effective teacher in Myanmar. You will 
use the textbook as a key resource in class; you can also use the textbook for independent 
self-study. 

While the content in the textbook is addressed to you, as a student teacher, it is also a 
resource for your teacher educators, who will serve as your facilitators and mentors as you 
develop key competencies in ICT. Throughout this course, you and your teacher educator 
will work together, using this textbook as a tool for learning.

When and where does ICT take place? 

The ICT subject has been allotted 24 periods of teaching for Year 1 of the four-year Education 
College  degree programme. Classes will be held on your Education College  campus.

What is included in the Year 1 ICT textbook?

The textbook organisation and content align with the syllabus of the four-year Education 
College  curriculum on ICT.

This textbook contains the following topics for Year 1 ICT:

•	 Computer system fundamentals;
•	 Media and Information Literacy;
•	 Internet safety and security;
•	 Basic troubleshooting;
•	 Word processing;
•	 Presentation;



2 Student Teacher Textbook

For each unit, you will be working through learning activities, both individually and with 
your peers as well as teacher educator, to deepen your knowledge, skills and attitudes on the 
topic. The Content Map below, highlights the expected learning outcomes and time 
allocations for each unit in this textbook. 

Content Map

Table A. Year 1, Semester 1, ICT Content Map 

•	 Introduction to Internet;
•	 Asynchronous conferencing; and
•	 Introduction to ICT in education.

Units Sub-units Lessons Learning outcomes TCSF Periods 

1. Introduction 1.1. Objective of 
Teaching ICT

1.1.1. 
Understanding 
ICT in Myanmar 
primary schools 
and classrooms

•	 Explain what ICT (beyond 
computers) is and why it is 
important for a teacher 
(including but not limited to 
teaching) in primary school;

•	 Understand the importance 
and describe the roles of ICT 
in Myanmar primary schools 
and classrooms

A5 2

1.2. Teacher 
Education 
Curriculum 
Relating to ICT

1.2.1. 
Understanding 
ICT Teacher 
Education 
Curriculum and 
its linkage with 
other subjects/
learning areas

•	 Describe the five main strands 
(basic ICT concepts, media 
and information literacy and 
digital citizenship, computer 
applications, Internet and 
communication, ICT in 
education) in the Teacher 
Education Curriculum

•	 Explain linkages between ICT 
and other subjects/learning 
areas such as ICT across 
curriculum, Reflective 
Practice and Essential Skills, 
and Practicum for primary 
school teachers.

A5

Year 1 Semester 1 - EDU1109 - Curriculum and Pedagogy Studies: Information and Communication Technology
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Units Sub-units Lessons Learning outcomes TCSF Periods 

2. Basic ICT 
Concepts

2.1. Computer 
System 
Fundamentals

2.1.1. Structures 
and functions of 
hardware within 
a computer 
system

•	 Describe the structures and 
functions of hardware within 
a computer system (input, 
central processing unit, output 
and storage);

•	 Describe the features, 
advantages, disadvantages and 
examples of input and output 
devices and select the 
appropriate use of devices in 
various scenarios;

A5, B1 3

2.1.2. 
Developments 
in computer 
systems

•	 Outline the developments in 
computer systems;

•	 Compare the characteristics of 
various types of computers;

A2, 
A2.2.1, 
A2.3.1

2.1.3. 
Understanding 
System 
Software, Types 
of Computers 
and File/Folder 
Management

•	 Understand functions of 
system software and 
application software and 
describe the basic functions of 
an Operating System such as 
Windows;

•	 Describe the functional 
characteristics of storage 
devices in terms of random or 
sequential access, volatile or 
non-volatile, data transfer rate 
and storage capacity

•	 Understand file and folder 
management.

A2, 
A2.2.1, 
A2.3.1,

3. Computer 
Application 
(Word 
Processing)

3.1. Basic 
Function and 
Troubleshooting

3.1.1. 
Performing 
Windows basic 
functions

•	 Perform basic functions on an 
Operating System such as 
Windows;

A5, B1 5

3.1.2. Installing 
fonts onto an 
Operating 
System

•	 Install fonts onto the system 
and demonstrate typing

A5, B1

3.2. Word 
Processing

3.2.1. Basic 
functions of 
word processing 
1

•	 Describe the basic features of 
a word processing application

•	 Create, open, view, save and 
close a new document 

•	 Type Myanmar font (Zawgyi 
and Unicode) in word 
document.

A2, 
A2.3.2
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Units Sub-units Lessons Learning outcomes TCSF Periods 

3.2.2. Basic 
functions of 
word processing 
2

•	 Do text, paragraph and table 
formatting

•	 Create document designs and 
layout

•	 Print a document

A2, 
A2.3.2

3.2.3. Basic 
functions of 
word processing 
3

•	 Describe and practise the 
basic functions of word 
processing such as Microsoft 
Word (typing in Myanmar 
font) (Zawgyi and Unicode), 
page setup, saving, 
formatting, printing, header 
and footer, bullets and 
numbering; creating tables, 
inserting pictures and charts).

A2, 
A2.3.2

4. Media and 
Information 
Literacy and 
Digital Citizenship

4.1. Media and 
Information 
Literacy (MIL)

4.1.1. 
Understanding 
the principles of 
Media and 
Information 
Literacy

•	 Explain what Media and 
Information Literacy is and 
why it is important for a 
teacher (including but not 
limited to teaching) in 
primary school

A5 2

4.1.2. The roles 
and functions of 
Media and 
Information 
providers

•	 Understand the difference 
between types of information 
providers and types of media

•	 Understand the functions of 
the different media and 
information providers and the 
role they play in a democratic 
society.

A5

Total number of Periods 12

This course prepares student teachers in Education Colleges to learn ICT under the learning 
area Curriculum and Pedagogical Studies, Course 2.1. Teaching the Basic Education 
Curriculum and Course 2.2. Mastering teaching as described in the Education College  
Curriculum Framework.

While there is an ICT subject in middle schools, there is no single ICT subject in the primary 
schools but primary schools in different regions and states in Myanmar may adopt a local 
curriculum which may include some elements of ICT, depending on the context in the 
relevant regions and states.

Year 1 Semester 1 - EDU1109 - Curriculum and Pedagogy Studies: Information and Communication Technology



Year 1 Semester 1 - EDU1109 - Curriculum and Pedagogy Studies: Information and Communication Technology

Student Teacher Textbook 5

The purpose of this course is to provide student teachers with basic knowledge of ICT-
related concepts and using ICT for teaching, learning and professional development and to 
prepare them to teach ICT in middle schools and in primary schools (the latter applies if 
ICT is included in the Local Curriculum). Student teachers will learn about the objectives of 
teaching ICT, the ICT curriculum in basic education and teacher education and other strands 
including basic ICT concepts, Media and Information Literacy and digital citizenship, 
computer applications, internet and communication and ICT in Education. The course 
contains learning activities that will help student teachers to remember and gain a deeper 
understanding of the content and apply ICT tools in their teaching and learning context.

Basic Education Curriculum Objectives

The aims of the Basic Education Curriculum are as follows:

After the completion of basic education, students will be able to:

	 a)	 Attend the school until the completion of basic education;
	 b)	 Develop ‘union spirit’ and appreciate, maintain and disseminate languages and  
		  literatures, cultures, arts and traditional customs of all national groups;
	 c)	 Become good citizens with well-developed five strengths including critical thinking  
		  skills, communication skills and social skills;
	 d)	 Apply their civic and democratic in daily lives, and become good citizens who abide  
		  by laws;
	 e)	 Be competent in Myanmar language which is the official language of the Republic  
		  of the Union of Myanmar and develop their skills in respective ethnic language and  
		  English;
	 f)	 Develop foundational knowledge and skills for higher learning and technical and  
		  vocational education;
	 g)	 Develop sound body and sportsmanship through participation in Physical Education  
		  activities and school health activities, and apply health knowledge in daily lives;
	 h)	 Appreciate and maintain natural environment and materialise its sustainability;
	 i)	 Become global citizens with awareness and appreciation of human diversity and  
		  abilities to practise basic knowledge of peace in their daily lives; and
	 j)	 Take pride in being a citizen of the Union of Myanmar.
Note: According to the Basic Education Law, the aims of basic education will be mentioned.
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Competency 
standard Minimum requirement Indicator(s)

A2. Know available 
instructional 
technology

A2.2. Demonstrate understanding 
of appropriate use of Information 
and Communication Technology 
(ICT) in teaching and learning

A2.2.1. Describe the function and purpose of online and 
offline educational tools and resources to support the 
teaching-learning process

A2.2.2. Evaluate and match available online and offline 
ICT tools and resources to curriculum content and 
pedagogical strategies including online and offline ICTs

A2.2.3. Describe and demonstrate the understanding of 
basic concepts and principles of Media and Information 
Literacy

A5. Know the subject 
content

A5.2. Demonstrate understanding 
of how to vary delivery of subject 
content to meet students’ learning 
needs and the learning context.

A5.2.1. Describe ways to contextualise content, learning 
activities for the age, language, ability and culture of 
students to develop understanding of subject related 
principles, ideas and concepts.

B1. Teach curriculum 
content using various 
teaching strategies

B1.2. Demonstrate capacity to 
apply educational technologies and 
different strategies for teaching and 
learning

B1.2.1. Use teaching methods and learning strategies 
appropriate for the class – culture, size and type

B2. Assess, monitor, 
and report on 
students’ learning

B2.1. Demonstrate capacity 
to monitor and assess student 
learning

B2.1.2. Use assessment information to plan lessons

B4. Work together 
with other teachers, 
parents, and 
community

B4.1. Demonstrate strategies 
for working together with other 
teachers, parents, and the local 
community to improve the learning 
environment for students

B4.1.1. Speak positively to others about school culture 
and the primary curriculum to promote understanding 
among parents

B4.1.2. Describe strategies to promote parents’ 
involvement in their child’s learning at school, at home 
and in the community

C1. Service to 
Profession

C1.4. Demonstrate responsibility 
and accountability for the use of 
education resources,

C1.4.1. Use school supplies and resources appropriately

Teacher Competencies in Focus

The content of this textbook is based on the Myanmar Teacher Competency Standards 
Framework (TCSF), which articulates the expectations for what you should know and be 
able to do in the classroom. The teacher competencies in focus for ICT include: 

Table B. ICT Teacher Competencies in Focus 

Year 1 Semester 1 - EDU1109 - Curriculum and Pedagogy Studies: Information and Communication Technology
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Source: Myanmar Teacher Competency Standards Framework (TCSF), Beginning Teachers, Draft Version 3.2. (May 2019) 

(pp 30 – 36)

Competency 
standard Minimum requirement Indicator(s)

D2. Engage with 
colleagues in 
improving teaching 
practice

D2.1. Improve own teaching 
practice through learning from 
other teachers and professional 
development opportunities

D2.1.3. Establish goals for own professional 
development as a teacher

D3. Participate in 
professional learning 
to improve teaching 
practice

D3.1. Demonstrate understanding 
of the importance of inquiry and 
research-based learning to improve 
teaching practice

D3.1.2. Search and analyse online or offline information 
on current trends and research-based practices in 
primary education and for specific subjects taught to 
improve one’s own content knowledge and teaching 
practice
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			   How do I use this textbook?

You can use this textbook both for your own self-study and as an in-class resource for 
learning activities facilitated by your teacher educator. Each unit in the textbook includes: 

			   Expected Learning Outcomes: These are listed at the beginning of each unit  
			   and at the beginning of each lesson. The expected learning outcomes indicate  
			   what you should know and be able to do by the end of the lesson or unit.

			   Learning Content: The learning content for each unit is broken down into  
			   units and lessons that cover subject content knowledge that is important for  
			   you to know. 

			   Learning Activities: The learning activities included in the textbook are  
			   individual activities that you can do to help reinforce and deepen your  
			   knowledge and understanding of a topic. Your teacher educator will also  
			   facilitate learning activities during class. These may be individual, partner,  
			   small group, or whole class activities designed to help you achieve the learning  
			   outcomes for each lesson. 

			   Unit Summary: At the end of the unit, there is a brief summary of the main  
			   points of the unit to help you review and remember the most important  
			   information. 

			   Review Questions: You can use the unit review questions to test your own  
			   understanding of the unit content, or to help you study for an exam. 

			   Further Reading: Each unit lists suggestions of additional resources on the  
			   topic. You can look these up in the library, on the internet, or in your Education  
			   College’s online learning portal to learn more about the topic. 

Year 1 Semester 1 - EDU1109 - Curriculum and Pedagogy Studies: Information and Communication Technology
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			   Unit Reflection: Taking the time to deliberately think about, or reflect, on  
			   what you have learned will help you remember and apply that learning, and  
			   make connections with other subject areas and real-life. Each unit ends with  
			   some suggestions on how you can reflect and follow-up on what you have  
			   learned in the unit.  

At the end of this textbook, you will find a Glossary with the definitions of words found 
throughout the textbook that might be new to you. These words are listed in alphabetical 
order. You will also find a list of all the Bibliography, which are the original sources of 
information used throughout the textbook.

Remember, your teacher educator is there to help facilitate your learning in this course. If 
there is material you do not understand in the textbook, be sure to ask your teacher 
educator, or your classmates, for help. As a student teacher, you are part of a community 
of collaborative learning within your Education College as you work – together with your 
peers and guided by your teacher educator.
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In this unit, you will have an overview of the Information and Communication Technology 
(ICT) subject in Education College degree programme.  

Expected learning outcomes

By the end of this unit, you will be able to:

• Explain what ICT (beyond computers) is and why it is important for a teacher
(including but not limited to teaching) in primary school;

• Understand the importance and describe the roles of ICT in Myanmar primary
schools and classrooms;

• Describe the five main strands (basic ICT concepts, media and information literacy
and digital citizenship, computer applications, Internet and communication, ICT
in education) in the Teacher Education Curriculum; and

• Explain linkages between ICT and other subjects/learning areas such as ICT across
curriculum, Reflective Practice and Essential Skills and Practicum for primary
school teachers.

Introduction
Unit

1
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This sub-unit provides explanations what ICT is and its importance for teachers and aims 
at explaining the importance and roles of ICT in primary schools.

By the end of the lesson, you will be able to:

•	 Explain what ICT (beyond computers) is and why it is important for a teacher 
(including but not limited to teaching) in primary school; and

•	 Understand the importance and describe the roles of ICT in Myanmar primary 
schools and classrooms.

What is ICT?

ICT is a short form of Information and 
Communication Technology and refers to a 
range of electronic tools for storing, processing, 
creating, displaying and exchanging 
information, and communicating.

Do you know?

In some contexts, the acronym ICT is 
used to refer to the phrase Information 
and Communication Technologies. You 
may also see the acronym ICTs or ICTS, 
which refers to the same phrase. Other 
similar terms such as IT and information 
superhighway may also be used.

Expected learning outcomes

1.1.1.
Understanding ICT in Myanmar primary 
schools and classrooms 

1.1. Objectives of Teaching ICT
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In addition to recognising the value that ICT tools offer in terms of improving the reach and 
quality of education, many countries, including Myanmar, increasingly regard mastering 
the basic skills and concepts of ICT as part of the core of education, alongside reading, 
writing and numeracy.

Figure 1.1. Benefits for education brought by ICT

ICT refers to much more than simply computers and the Internet. It includes other devices, 
services and technologies such as telephone, television, radio, satellite system, video, 
video conferencing, DVDs and email. In some developing context where computers and 
access to the Internet are limited, the use of other electronic devices, services and 
technologies is critical because they can be easily accessed by many people and more 
affordable. For instance, radio may be a useful ICT device to disseminate messages to 
remote areas of Myanmar.

Development in ICT has changed the world dramatically, bringing about significant 
changes in society and in labour markets. ICT has changed the ways people communicate 
with one another. Countries that are using ICT extensively have become knowledge 
societies, which are reliant on creating, sharing and using electronically communicated 
knowledge for their prosperity.

Recognising that ICT tools make information exchange easier, faster and cheaper, it has 
become clear that ICT tools offer a range of benefits for education. In particular, ICT tools 
offer the potential to make education more accessible, improve the quality of education, 
and provide an effective and efficient management tool.

Benefits for education brought by ICT

Making
education more 

accessible

Improving the quality
of education

Providing an 
effective and efficient 

management tool

Year 1 Semester 1 - EDU1109 - Curriculum and Pedagogy Studies: Information and Communication Technology
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Making education more accessible

When used effectively, ICT can make education more accessible by improving access to 
information. ICT provides access to free radio and television programmes, educational 
DVDs, mobile phones, and internet-based storehouses of knowledge such as online 
encyclopedias, maps and geographical information, dictionaries and thesauri, curriculum 
materials and lessons and online learning portals such as e-libraries. ICT also increases 
access to human experts, peers and colleagues otherwise unreachable because of 
geographical barriers.

ICT can also reach people whose education has been limited for various reasons, perhaps 
social or cultural, or because of geographic factors, or maybe from a lack of time to attend 
classes or a shortage of teachers. ICT can help overcome geographic barriers by facilitating 
distance learning, and so bring education to people living in areas that are difficult to 
reach through radio, television, Internet and community telecenters, that is, public places, 
such as libraries where community members can access various ICT.

ICT can provide affordable learning anywhere and anytime. Users do not need to be 
gathered together in one place and at the same time but may access learning materials and 
resources wherever and whenever it is convenient through telephone, DVDs, computers, 
Internet, podcasts and vodcasts. Podcasts is a contraction of iPod and broadcast, referring 
to an audio file, such as a radio programme, which can be downloaded from the Internet 
to computers or portable devices like iPods and MP3 players. Vodcasts is a contraction of 
video podcast, which is a video file, such as a television programme, which can be 
downloaded from the Internet to computers.

These skills are required to enable citizens to function in a society in which ICT is a part 
of everyday life. Furthermore, these skills are vital in the modern workplace. Companies 
are increasingly seeking employees who have the ability to utilise ICT effectively in 
their everyday work and who have the skills to maximise the potential of ICT to enhance 
productivity in the workplace.
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The last but not the least, ICT can provide sustainable lifelong learning as it provides 
learning spaces and opportunities for learning beyond classrooms such as online courses 
and open universities, which allow students to do much of their coursework at home by 
distance learning.

Improving the quality of education

ICT can improve the quality of education by improving students’ motivation, personalising 
student learning, enhancing student learning, giving feedback and reinforcement, 
enhancing the quality of teaching and improving teacher education.

The use of sound, images, video and animation in video materials and computer software 
engages students and holds their attention, helping make learning more interesting. For 
example, it allows animations and simulation of processes that would not otherwise be 
available in the classroom. These might include an animation of the heart pumping blood 
through the body or a simulation of the dissection of a frog through virtual reality or 
augmented reality.

By tailoring the level of activity to meet each student’s requirements, ICT can personalise 
learning for all students, allowing students to learn at their own pace. For instance, 
computer-based learning may provide fast learners with more challenging questions while 
learners who need more help can go through the content at a slower pace.

With ICT, students can learn better by doing and interacting. ICT can enhance student 
learning through making learning an active process. ICT can allow students more control 
over what they can do and what they learn. With ICT, students have more opportunities to 
share ideas and work in groups, thereby improving their teamwork and communication 
skills.

ICT can be used to quantify learning process, often as a percentage score, or sometimes 
by showing students where or why they went wrong. Students report that through ICT-
based feedback and reinforcement, they can assess their learning independently of teachers 
in a judgment-free environment, and more easily see where improvements are needed. 
These can be done through online quizzes.

Year 1 Semester 1 - EDU1109 - Curriculum and Pedagogy Studies: Information and Communication Technology
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Providing an effective and efficient management tool

ICT provides an effective and efficient 
management tool that can be used for improving 
the efficiency of education planning and 
delivery and facilitating policy making and 
management.

ICT has the potential to facilitate the compilation 
of educational statistics at the system and the 
school levels. ICT can also facilitate the rapid 
and cost-effective creation and distribution of 
socially, culturally and linguistically appropriate 
learning content.

ICT can additionally aid schools, principals and education officers at different levels in 
monitoring performance and improving the utilisation of physical and human resources 
such as through the use of an Education Management Information System.

Do you know?

Myanmar is using an Education 
Management Information System 
(EMIS) to collect school data, which are 
useful for understanding teacher need 
at the regional level and for education 
planning for teacher deployment. 
Furthermore, it can aid communication 
through email, SMS (short message 
service) and social media applications 
between schools, parents and central 
decision-makers.

ICT accompanied with sound pedagogical training can help teachers prepare and deliver 
lessons more student-centred. In addition, ICT can improve the speed and efficiency of 
administrative tasks, enabling teachers to give more time and energy to teaching their 
students. There are a lot of Internet resources for teachers, which can be accessible through 
online e-library, web-based software and productivity software that can help teachers 
identify and customise locally appropriate teaching materials.

ICT can also be used to enhance learning among student teachers like you and in-service 
teachers, thereby improving teacher education. This can be done through access to a wide 
variety of multimedia resources such as training video showing good practices in teaching.
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Learning activity 1

After reading the text above, write a list of questions required to be clarified during the 
class.

Learning activity 2

The text below is a step-by-step guide for this activity. While following the teacher 
educator’s guidance, please use the text below to complete the tasks.

Google is a website which is a web search engine developed by Google LLC. There are 
millions of websites on the Internet, and it is not easy to use without a search engine. 
Using Google, you can get many search results by entering the keywords you want to 
search. 

Step 1: Open Web Browser.
Step 2: Type www.google.com.

Using Google Search on Web Browser

Figure 1.2.

Figure 1.3.
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Step 3: Type the keyword/s you want to search.
Step 4:	Search result will be shown, in All. You can filter to show only Images, Videos, 
News, Maps or other options.

Figure 1.4.

Using Google Search on Android

Using your Android device (Android smartphone, tablet, and so on), you can search on 
the Internet by using Google Search in many ways. You can use Web Browser on your 
Android device. You can also use Google Bar to search on the Internet by entering text 
and also using voice command. 

Step 1: Tap on the  Microphone icon.

Google Bar: Voice Command Figure 1.5.

Figure 1.6.

Step 2: Speak the word/s you want to search while Google 
Assistant is listening.
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Step 1: Tap on the Google Bar.
Step 2: Type the keyword/s you want to search.

Google Bar: Text Figure 1.7.

Advanced Google Web Search and Strategic Searching Strategies

1. Every keyword is important in the searching. For example, search results are not
the same for the keyword ‘ICT’, ‘An ICT’ and ‘The ICT’.

2. Keyword placing can get you different results. For example, you will see different
results when searching ‘Education College Myanmar’ and ‘Myanmar Education
College’.

3. You can exclude a word using a Minus Sign ‘-’ before the word you do not want
to include.

4. Pay attention to URL domains. URL domain tells people what kind of organisation
created the website. Companies sell products, while organisation, educational
institutions, and government entities usually aim to share knowledge and improve
communities.

- .com = company (commercial)
- .gov = government
- .edu = educational institution
- .org = organisation

Year 1 Semester 1 - EDU1109 - Curriculum and Pedagogy Studies: Information and Communication Technology
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Now is your turn to try to search the following using Google. Write down the number of 
search results and explain whether you think you can get good and useful results from the 
first page of the search results.

1. ICT
2. ICT in Education
3. ICT in Education in Myanmar
4. ‘ICT in Education in Myanmar’
5. ICT in Education -Myanmar

Search keyword Number of search results Do you think the results are 
good and useful?

ICT

ICT in Education

ICT in Education in Myanmar

‘ICT in Education in Myanmar’

ICT in Education -Myanmar
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QR Codes

Quick Response Code, abbreviated to QR Code, is a 
type of two-dimensional barcode. See the following 
steps on how to use QR codes to access website link.

Step 1: Install a QR code scanner application into 
your smartphone.
Step 2: Open QR code scanner application.
Step 3: Scan the QR code using the application.
Step 4: You can go to the website link by simply 
tapping the link.

Figure 1.9.

Figure 1.8.

				Learning activity 3

Test your understanding

There is a lot of confusion about ICT. Misunderstandings may occur when people are 
afraid or unsure about ICT. Identify which statements are true and which are false below.

1. As there is the increasing use of ICT, there will be less demand for teachers.
2. Placing ICT in schools will automatically improve the quality of education that

students receive.
3. The Internet is unsafe for students to use because there are so many dangerous

materials available on it.
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Think individually about the following questions. Choose the most appropriate answer.

6. Identify which of the following technologies are part of ICT. (Check all that apply)

7. You have developed a course named ‘Basic ICT literacy’ that you want to make it
available to people at different locations. Individuals can take the course at any time
that is convenient for them. You also want to the course to be available throughout the
year, allowing students to review the materials after they have taken the course. Which
technologies might you use in this situation? (Check all that apply)

Email Radio Fixed-line 
phone Social media CDs Fax machine Whiteboard

A B C D E F G

4. I can implement ICT in my future basic education school and improve education
without using computers and the Internet.

5. Towns and villages which are currently without stable supply of power or phone
lines may still be able to utilise ICT in teaching.

Radio Internet Television CDs or 
DVDs

Computer
networks

A B C D E

8. Rather than using computers and the Internet, the use of television and radio and other
low cost technologies is important to countries such as Myanmar because … (Choose
the best three answers)
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A. They are as effective in achieving educational goals.
B. They can be used without knowing how to read and write.
C. They require less electricity.
D. They are still accessible to many people.
E. They are still affordable compared to more sophisticated technologies.

Personal goal Way to achieve your goal

1

2

9. Write down AT LEAST TWO personal goals that you want to achieve after
learning this ICT subject at Education College. For EACH of the goals, suggest
a way to help you achieve your goals. You may follow the following template
below:

Review questions 

1. Reflect on what you have learnt in the lessons under this unit, and assess your
understanding of the subject.
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2. Use your words to explain to your peers why ICT is important in Myanmar primary
schools and classrooms.

Yes No Not sure

Lesson 1.1.1.

I can explain what ICT (beyond computers) is and why it is important for a teacher 
(including but not limited to teaching) in primary school.

I understand the importance and can describe the roles of ICT in Myanmar prima-
ry schools and classrooms.
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ICT is not just a subject in Education College that prepares you to teach ICT in basic 
education schools. It is also a subject to equip you with necessary competencies to utilise 
ICT effectively across different subjects/learning areas. In this unit, you will have an 
overview of the main strands of the teacher education curriculum relating to ICT and its 
linkages across subjects/learning areas.

Expected learning outcomes

1.2. Teacher Education 

Curriculum Relating to ICT

1.2.1.
Understanding ICT Teacher Education 
Curriculum and its linkage with other 
subjects/learning areas

By the end of the lesson, you will be able to:

•	 Describe the five main strands (basic ICT concepts, media and information literacy 
and digital citizenship, computer applications, Internet and communication, ICT 
in education) in the Teacher Education Curriculum; and

•	 Explain linkages between ICT and other subjects/learning areas such as ICT across 
curriculum, Reflective Practice and Essential Skills and Practicum for primary 
school teachers.

Year 1 Semester 1 - EDU1109 - Curriculum and Pedagogy Studies: Information and Communication Technology
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Over the four years of the Education College degree programme, all student teachers 
including you are required to take ICT as a compulsory subject. You will learn basic 
knowledge of ICT-related concepts and using ICT in education. The curriculum will 
prepare you to teach ICT in middle schools and in primary schools (the latter applies if 
ICT is included in the Local Curriculum) and to effectively use ICT in education.

The ICT subject is designed as a spiral curriculum, which means throughout the four years, 
you return to familiar concepts, each time deepening your knowledge and understanding. 
For instance, after learning basic computer applications skills in Year 1, you will revisit 
the skills and learn more in-depth the skills in later years of your degree programme. 
To achieve this, the course is divided into two cycles. The first cycle (Years 1 and 2) is 
repeated at a deeper level in the second cycle (Years 3 and 4) to enable you to return to 
ideas, experiment with them, and share with a wider range of practices in the classroom.

This ICT subject provides the opportunity for you to integrate educational theory and 
psychologies, subject knowledge and knowledge of pedagogies. It provides you with the 
opportunity to develop your confidence in ICT subject matter knowledge and learn how 
to translate this knowledge in a way that students will be able to understand (pedagogical 
content knowledge). It allows you to learn, explore and practise ICT subject matter 
knowledge and see how you can adjust subject matter content and delivery to meet the 
needs of the students in your classes.

ICT in Teacher Education Curriculum

This ICT subject in the Teacher Education Curriculum comprises five strands or thematic 
areas, namely basic ICT concepts, Media and Information Literacy and digital citizenship, 
computer applications, Internet and communication, ICT in education.

Figure 1.10.	 ICT in the Teacher Education Curriculum.

ICT in the
Teacher Education 

Curriculum

Basic ICT 
concepts

Media and 
Information 

Literacy and digital 
citizenship

Computer 
applications

Internet and 
communication

ICT in 
education
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Under basic ICT concepts, you will learn about the structures and functions of hardware 
within a computer system, the developments in computer systems, basic operation of 
system software and application software and characteristics of various types of  
computers.

Media and Information Literacy is defined as a set of competencies that empower citizens 
to access, retrieve, understand, evaluate and use, create, as well as share information and 
media content in all formats, using various tools, in a critical, ethical and effective way in 
order to participate and engage in personal, professional and societal activities. Digital 
citizenship has a broader meaning than Media and Information Literacy by going beyond 
media-related skills and is defined as being able to find, access, use and create information 
effectively; engage with other users and with content in an active, critical, sensitive and 
ethical manner; and navigate the online and ICT environment safely and responsibly, 
while being aware of one’s own rights. Some topics such as Internet safety and security, 
intellectual property rights and health and work issues are included. The Teacher Education 
Curriculum will enrich your knowledge on these concepts and strengthen your 
understanding about the importance of these concepts in education.

In addition to concepts and theories, one of the important elements of the ICT subject is 
to train you on how to use ICT particularly the common computer applications, such as 
basic functions and troubleshooting, word processing, spreadsheet, presentation, 
information management and basic multi-media editing. These computer applications are 
useful not only in education but also for your daily life.

Internet has become an inseparable part of your life as most of you should have accessed 
to the Internet either at your home or at the Education College. Another strand you will 
learn is the basic knowledge about Internet such as how it functions and what the common 
services available in a networked environment are. Furthermore, you will learn 
asynchronous and synchronous conferencing applications which you can use via the 
Internet for communication.

Year 1 Semester 1 - EDU1109 - Curriculum and Pedagogy Studies: Information and Communication Technology
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As a cross-cutting subject, ICT is not only useful 
for those who are going to teach ICT in basic 
education but also important for all teachers 
who are specialised in various subjects. For 
example, a Geography teacher may use ICT to 
show maps and satellite images to train map 
reading skills of students and to explain real life 
examples to students; an English teacher may 
show a short audio and/or video clip of a poem to 
help students understand the pronunciation and 
context of the poem. There are more examples 
of how ICT can be used in a primary classroom 
as what you discussed in the previous lesson.

Apart from this ICT subject, you will have chances to learn more about and apply ICT 
skills in learning areas including Reflective Practice and Essential Skills and Practicum. 
In the former, you will have a chance to understand your ICT competencies/skills and 
learn about ways to strengthen the competencies/skills. In the latter, you will make use of 
ICT in your teaching practice and professional development. 

Do you know?

An online e-library is to be available for 
all Education Colleges in the new 
Teacher Education Curriculum. All 
student teachers are provided with an 
account to access its e-library to search 
and share teaching and learning 
materials and to make use of its 
e-learning platform to do online self-
learning, to keep a learning portfolio in
an organised way and to record progress
in achieving teacher standards and
Praticum.

At the last but not the least, you will be able to apply what you learn about the effective 
use of ICT in education for various purposes including but not limited to teaching 
preparation and collaboration, active teaching and learning, assessment, professional 
development and education management. This is particularly important as ICT skills is 
one of the essential skills that a 21st century teacher should be equipped with.

Linkages with other subjects/learning areas

Learning activity 1

After reading the text above, write a list of questions required to be clarified during the 
class.
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Learning activity 2

ICT competency

1

2

3

Classification ICT competency
Self-reflection 

(1=least competent; 
5=most competent)

			  Learning activity 3

Imagine you became a primary school teacher after you graduate from the teacher education 
degree four years later. What kinds of ICT competencies do you need to be equipped 
with in order for you to fully utilise the potential of ICT use in Myanmar primary school 
classrooms? Write down AT LEAST THREE ICT competencies you can think of below.

Divide yourself in groups and share your answers from Learning activity 2. Group similar 
ICT competencies together and classify different ICT competencies suggested by your 
group members. Leave the last column ‘Self-reflection’ blank as you will be asked to 
complete this column under Learning activity 4.
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Learning activity 4

For each type of the ICT competencies discussed in Learning activity 3, evaluate your 
own current level of competency by putting 1 as least competent and 5 as most competent 
in the last column of Learning activity 3. For instance, if you think you have not acquired 
the relevant ICT competency, you may put 1. If you think you know a little about the 
relevant ICT competency but you are not good at it, you may put 3. If you think you know 
well about and have acquired the relevant ICT competency, you may put 5.

2. What are the main strands of ICT subject in teacher education? How do you see
the importance of each main strand in teaching Myanmar primary schools and
classrooms?

3. What are the linkages between ICT and other subjects/learning areas?

Yes No Not sure

Lesson 1.1.2.

I can describe the five main strands (basic ICT concepts, media and 
information literacy and digital citizenship, computer applications, Internet and 
communication, ICT in education) in the Teacher Education Curriculum.

I can explain linkages between ICT and other subjects/learning areas such as ICT 
across curriculum, Reflective Practice and Essential Skills, and Practicum for 
primary school teachers.

				 Review questions 

1. Reflect on what you have learned in the lessons under this unit and assess your
understanding of the subject.
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Key messages

• ICT is a short form of Information and Communication Technology and refers to a
range of electronic tools for storing, processing, creating, displaying and exchanging
information and communicating, not limited to simply computers and the Internet.

• Countries that are using ICT extensively have become knowledge societies which are
reliant on creating, sharing and using electronically communicated knowledge for
their prosperity.

• ICT tools offer a range of benefits for education. In particular, ICT tools offer the
potential to make education more accessible, improve the quality of education and
provide an effective and efficient management tool.

• Professional development for teachers are important in successfully integrating ICT
in education. Teachers like you need training to use ICT so that you can be at ease
with ICT, adapt your pedagogical approaches and your roles to use ICT effectively.

• This ICT subject in the teacher education curriculum comprises five strands or thematic
areas, namely basic ICT concepts, media and information literacy and digital
citizenship, computer applications, Internet and communication, ICT in education.

• There are close linkages between this ICT subject and other subjects/learning areas.
ICT are not only used in this ICT subject but also in other subjects and learning areas
including Reflective Practice and Essential Skills and Practicum.

• A teacher in the 21st century should be equipped with ICT competencies.

Unit Summary
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Further reading

1.1.

UNESCO. E-learning Series on ICT in Education.http://archive1.unescobkk.
org/fileadmin/user_upload/ict/Teacher_Training_Workshops/UNESCObkkE-
LearningSeriseOnICTInEducation.zip

Unit reflection

1. How do you think the competencies gained from this ICT subject is helpful for you
as a student teacher while you are in your Education College?

2. How will integrating ICT into other learning areas and subjects support accelerating
learning process? How can you use ICT competencies to foster learning of your
students in classrooms?
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Expected learning outcomes

By the end of this unit, you will be able to:

• Describe the structures and functions of hardware within a computer system
(input, central processing unit, output and storage);

• Describe the features, advantages, disadvantages and examples of input and output
devices and select the appropriate use of devices in various scenarios;

• Outline the developments in computer systems;
• Compare the characteristics of various types of computers;
• Understand functions of system software and application software and describe

the basic functions of an Operating System such as Windows;
• Describe the functional characteristics of storage devices in terms of random or

sequential access, volatile or non-volatile, data transfer rate and storage capacity;
and

• Understand file and folder management.

Basic Information 
and Communication
Technology (ICT) 
Concepts

Unit
2

In this unit, you will be introduced the structures and functions of hardware within a 
computer system, the developments in computer systems, basic functions of an Operating 
System, computer storage and file/folder management.
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Computers have become more prevalent in our daily life. A computer is an electronic 
device which is capable of receiving data and processing data in order to produce results 
which are useful for us. In computing, data are translated into a form that is efficient for 
processing.

In history, computers were only formed as calculating devices, from a simple manual 
device such as abacus to digital calculator, used in doing calculations. As the time passed, 
the development process of the machine occurred from 1940s and to the present.

2.1. Computer System 

Fundamentals

By the end of the lesson, you will be able to:

• Describe the structures and functions of hardware within a computer system
(input, central processing unit, output and storage); and

• Describe the features, advantages, disadvantages and examples of input and
output devices and select the appropriate use of devices in various scenarios.

Expected learning outcomes

2.1.1.
Structures and functions of hardware within 
a computer system
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Computers 

A computer may be divided into several 
fundamental units: input, central processing 
unit and output. An input device is any 
device that enters information into a 
computer from an external source. A 
processing device is any electronics that 
process or transform information provided 
as an input to a computer to an output. An 
output device translates the computer output 
into a form understood by human beings.

Processing device 

The Central Processing Unit (CPU) is 
the main part of a computer in which all 
processing is carried out. It also controls 
the activities of the whole computer 
configuration. CPU speed determines 
how fast the computer can perform tasks. 
It comprises an arithmetic and logic unit 
(ALU), a control unit (CU) and memory. 
The CPU is used for storing data as well as instructions, issuing commands to all parts of 
a computer system and carrying out data processing and sending results to output.

Input device 

Different devices are used to read data and to input the data into a machine. These devices 
are called input devices. The input devices read the necessary data into the machine and 
translate all data into electronic pulses so that computers can understand it. A computer 
cannot deal with data unless in a language it understands. Some examples of common 
input devices are keyboard, mouse, scanner and bar code reader.

Misconception

When a computer is running slow, there 
are different reasons for it and the CPU is 
probably only one of them. Other reasons 
may include insufficient memory or poorly 
coded software that constantly takes up a lot 
of memory and system resources.

CPU, Memory, Input & Output

https://www.khanacademy.org/computing/
computer-science/how-computers-work2/v/
khan-academy-and-codeorg-cpu-memory-
input-output
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Figure 2.1. CPU (Central Processing Unit) Figure 2.2. RAM (Memory)

An arithmetic and logic unit carries out arithmetic operations like addition, subtraction, 
multiplication and division and other logical actions such as AND and OR functions and 
operates on data available in the main memory and send them back after processing. A 
control unit directs all operations inside a computer and can be known as the heart of the 
computer because it controls and coordinates all hardware operations including the CPU, 
input and output devices. The memory is also called the computer’s main memory or 
primary memory as it is able to store information, which can be recalled and accessed 
when required.

Output device

The results of any computer 
processing have to be communicated 
to the user. Output devices translate 
the computer output into a form 
understood by human beings. 
Common output devices are computer 
monitor screen, printer and speaker.

Figure 2.3. Block diagram of a computer
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The input unit is provided to translate all data into electronic signals so that computer can 
understand it. For instance, the barcode reader reads the barcode (data) and then search 
information about the goods (for example, items, prices, and so on.) in the point of sale 
system (machine). The barcode reader translates the barcode so that the point of sale 
system can understand it.

Another example is that to access a website, the user opens an internet browser and, using 
the keyboard, enters a web address into the browser (input). The computer then uses that 
information to locate the correct website (data/information processing) and the content of 
the desired site is displayed in the web browser (output).

Learning activity 1

Have you ever seen these devices in daily life? What is the name of each of the device? 
Where do you usually see these devices? Complete the following table based on your 
knowledge.

Figure 2.4. Devices in daily life

A B C D E

F G H I J
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Item Have you seen the 
item in daily life?

What is the name of the 
item?

Where do you usually see the 
item?

A Yes / No

B Yes / No

C Yes / No

D Yes / No

E Yes / No

F Yes / No

G Yes / No

H Yes / No

I Yes / No

J Yes / No

Learning activity 2

Identify the items in Learning activity 1 and whether each item is considered to be 
input, processing and/or output device and describe the main function of each item. 
You may discuss with your classmates on the answers.

Item Is it an input, processing and/or 
output device? Main function

A Input / Processing / Output

B Input / Processing / Output

C Input / Processing / Output

D Input / Processing / Output

E Input / Processing / Output

F Input / Processing / Output

G Input / Processing / Output

H Input / Processing / Output

I Input / Processing / Output

J Input / Processing / Output
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Learning activity 3

Scenario A:
You are a teacher drafting an examination paper for your class.

Scenario B:
You are a waiter of a restaurant who takes food order from customers.

Scenario C:
You are an administrative assistant in an office who keeps personnel records including photos and personal information 
of the staff.

Scenario D:
You are a cashier of a department store who collects payments from customers based on the items they purchase.

1. What input device(s) do you use?
2. What output device(s) do you use?
3. Describe the main function of the device(s) you choose.
4. Explain why the devices are suitable in the scenario.

Some examples of input and output devices are provided for you to choose. In your 
discussion, you should consider pros and cons of using different devices and come up 
with a decision on which devices are the most suitable in the scenario.

Choose ONE of the following scenarios which ICT may be used to facilitate the tasks and 
answer the following questions in groups.
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Mouse Monitor Photocopier Keyboard

Speaker Modem Flash drive Memory card reader

Printer Scanner CD-ROM CD-ROM drive

Laptop Desktop Tablet Smartphone

Voice recognition Digital camera Projector Microphone 

Joystick Digital video recorder Optical character 
recognition Headphone

Review questions 

1. What is the main new thing you have learnt from this lesson?
2. Is there anything from this lesson unclear to you? If so, write it down and discuss

with your peers or teacher educators to try to clarify it.
3. Is there any challenge for you to understand this lesson? If so, write down the

challenge that you have faced and explain how you tackle the challenge.
4. Highlight the new keywords that you have learnt from this lesson. Make sure that

you understand the new keywords and their definitions.
5. If you are asked to teach this lesson to basic education students, do you find the

activities relevant and useful? Please explain.
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Six generations of computers

There are six generations of computers. 
Computer generation is a term related 
to the evolution and adaptation of 
technology. A generation indicates a major 
breakthrough, such as reducing the size of 
processors as well as increasing capacity 
and speed.

First Generation: The first computer 
systems were used vacuum tubes and 
magnetic drums and the sizes were large 
as an entire room. Examples of first-
generation computers are UNIVAC and 
ENIAC computers.

Second Generation: The use of transistors 
which are made from semiconductors by 
replacing the vacuum tubes in computers 
was called second generation in computer 
history. The advantages from previous 
generation are, reducing heat, decreasing 
in size and increasing in the storage 
capacity.

By the end of the lesson, you will be able to:

• Outline the developments in computer systems; and
• Compare the characteristics of various types of computers.

Expected learning outcomes

2.1.2.
Developments in computer systems

History of computers – A timeline

https://www.youtube.com/
watch?v=pBiVyEfZVUU

 Do you know?

Charles Babbage was recognised to be the 
father of computing after his invention of 
Analytical Engine in 1837.
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Third Generation: As the development of 
Integrated Circuits (IC) in the circuitry, 
which is equivalent to tens of transistors 
on a single chip of semiconductor, the use 
of IC in computer systems increased the 
speed and efficiency of the computers, and 
became the third generation of computer 
systems.

Fourth Generation: Development of the 
Microprocessor, a single silicon chip built 
up with thousands of integrated circuits, 
makes the fourth generation of computers 
to become faster and more powerful 
than earlier computers. Size of personal 
computers (PCs) is reduced to the size of 
desktops and laptops nowadays. Fourth 
generation computers are still in use at 
present.

Fifth Generation: Computers having Artificial Intelligence (AI) is said to be the fifth 
generation of computer systems. The computers become extremely fast and the size 
is reduced dramatically so that a computer can even fit in the pocket (for example: 
smartphone). AI makes it possible for computers to learn from experience, process large 
amount of data to identify patterns and perform tasks similar to what human beings can do. 
Intelligent assistance including voice recognition technology such as, Google’s Assistant, 
Apple’s Siri and Microsoft’s Cortana are the examples of AI technology.

Computer history

https://www.youtube.com/watch?v=HEmFqohbQCI
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Type Characteristics Usage Remarks

Supercomputers
Most powerful large sized 

computers in term of speed and 
accuracy.

Science Research, Military, 
Weather Forecast, Movie 

Computer-generated 
imagery, and so on.

Large rack-type computers

Mainframe computers

Powerful large sized computer 
types which can handle massive 
amounts of data and thousands 

of users can access data 
simultaneously.

Banking industry, Cloud 
storage, Hospitals, Airline 

companies, and so on.
Large rack-type computers

Minicomputers

Mid-range computers with lesser 
computing power, cost and 

space needed than mainframe 
computers.

File and database server, 
Print server, FTP server, 
and so on. in LAN size 

networks.

Small rack-type or tower-
type computers

Microcomputers and 
mobile computers

Smallest sized personal 
computers, such as Desktops, 

Laptops, Smartphones and 
Tablets

Multipurpose single user 
computers.

From desktop type to 
smartphone, varies in size.
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Sixth Generation: Further development of robotic technology is called sixth generation 
of computer systems. As the technology improves, the price decreases. Computers will 
even be able to think and make decisions, just like human beings do. The sixth generation 
of computers is said to have a good resemblance with the human brain. They are able to 
understand feelings and emotions and people can control them physically.

Classification of computers

Table 2.1.
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Learning activity 1

Write down the main characteristics of the computers in each generation in the following 
timeline.

2025

2015

2005

1995

1985

1975

1965

1955

1945

1935

First Generation
----------------------------------
----------------------------------
----------------------------------
----------------------------------
----------------------------------
----------------------------------

Third Generation
----------------------------------
----------------------------------
----------------------------------
----------------------------------
----------------------------------
----------------------------------

Fifth Generation
----------------------------------
----------------------------------
----------------------------------
----------------------------------
----------------------------------
----------------------------------

Second Generation
----------------------------------
----------------------------------
----------------------------------
----------------------------------
----------------------------------
----------------------------------

Fourth Generation
----------------------------------
----------------------------------
----------------------------------
----------------------------------
----------------------------------
----------------------------------

Sixth Generation
----------------------------------
----------------------------------
----------------------------------
----------------------------------
----------------------------------
----------------------------------
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Learning activity 2

In the fifth generation of computers, Artificial Intelligence (AI) is considered to be the 
trend of ICT development. How do you envision AI can be beneficial to education? Write 
down what the possible uses of AI are to support teaching and learning.

Learning activity 3

In the following education scenarios, identify what type of computers is the most 
appropriate for use. Circle A, B, C or D in each education scenario and justify your 
answers.

A. supercomputers
B. mainframe computers
C. minicomputers
D. microcomputers and mobile computers

No. Scenario Type of computers Justification

1 Downloading some pictures from the Internet and 
showing them in class A      B      C      D

2 Storing digital files and printing those files within the 
Education College campus A      B      C      D

3 Editing a short video clip about Myanmar poems A      B      C      D

4 Managing the Education Management Information 
System (EMIS) at the national level A      B      C      D

Possible uses of Artificial 
Intelligence (AI) to support education
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2.1.3.
Understanding system software, types of 
computers and file/ folder management

Expected learning outcomes

By the end of the lesson, you will be able to:

• Understand functions of system software and application software and describe
the basic functions of an Operating System such as Windows;

• Describe the functional characteristics of storage devices in terms of random or
sequential access, volatile or non-volatile, data transfer rate and storage capacity;
and

• Understand file and folder management.

Computer system

A computer system is a basic, complete and functional computer, including all hardware 
and software required to make it functional for any user. It should have the ability to 
receive user input, process data and with the processed data, create information for future 
storage and/or output.

From an organisational point of view, a computer system consists of hardware (equipment) 
and software (programs) and sound. From a functional point of view, a computer is an 
information processing system capable of storing and manipulating numbers, words and 
pictures. From a user point of view, a computer may be a teaching machine, a source 
of reference materials such as dictionaries and encyclopedias, a companion for playing 
games and tool for problem solving.

To summarise the three points of view, a computer can be defined as a collection of 
hardware and software for data processing (for example, calculation), information 
processing (for example, database) and knowledge processing (for example, AI).
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Hardware

Application
Software

System
Software

Understanding system software and application software

System software is a type of software or 
computer program that is designed to 
operate the hardware and application 
software. Some examples of object-
oriented programming languages to 
develop system software are JAVA and C++. There are three components in system 
software: the Operating System, utility programs and language processors.

Operating Systems

https://www.youtube.com/
watch?v=pTdSs8kQqSA&vl=en

Hardware is a physical part of the computer system, such as the system unit, video 
monitor, printer, keyboard, mouse, scanner and other peripheral devices. Software is the 
name given to any kind of program which tells the hardware what to do. The hardware 
is visible and tangible and the software can be regarded as the soul of the computer. A 
computer without software is like a car without gasoline, a smartphone without SIM card 
and a camera without film.

Figure 2.5. Computer system 

User
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The Operating System tells the computer to perform functions such as how to load, store 
and execute programs, how to manage resources available. Utility programs are designed 
to perform functions that are not available in application software, such as formatting a 
disk and creating a directory. The most well-known system software is the Operating 
System (OS), and the examples are Microsoft’s Windows OS, Apple’s iOS, Ubuntu OS 
and Google’s Android OS. 

Application software is a type of software designed for end-users to perform specific 
user’s task. It is also called applications or Apps for short. Application software allows a 
user to prepare a document, design a financial worksheet or create a useful database. 
Some examples of the application software are Microsoft Word (which is included in 
Microsoft Office), media players, Google Chrome, Zapya, Viber and PDF reader.

Operating System and its basic functions

Operating System (OS) is the most well-
known system software which can 
operate hardware and acts as the platform 
for end-users’ application software.

The basic functions of the OS are:

• Hardware Management;
• System Resource Management;
• File and Folder Management / Data Management; and
• Provide environment for Application Software.

Microsoft Windows

Microsoft Windows is the one of the
most commonly used Operating System
in the market. Over 90% of Persona
Computer (PC) is using Microsoft
Windows. It is developed and sold by
Microsoft Corporation. Its basic functions/features are as follows:

Basic Functions of an OS

https://www.youtube.com/
watch?v=BhuU7eNRojs

Microsoft Windows History

https://www.youtube.com/
watch?v=m9gcDoVuvmg
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There are two main types of storage devices, namely primary and secondary storage 
devices. Primary storage devices are generally small in size and it is used for storing data 
for a temporary period. Most of them are installed in a computer and allow faster access 
to data. An example is RAM (Random Access Memory) in a computer. Secondary storage 
devices are of larger storage capacity and can store data for a longer period of time. These 
devices can be either external or internal to a computer. Examples are HDD (Hard Disk 
Drive), DVD and USB flash drive.

Input (Data) Processing
Output 

(Information) Storage

You will learn more about the operations of Windows in Unit 3.

Computers as storage devices

The basic flow of a computer system includes data (input, processing, information 
(output and storage. It is important that computers can serve the purpose of storing 
information.

Figure 2.6. Basic flow of a computer system

• Provide Graphical User Interface (GUI), which allows users to interact with the
system and applications through graphical icons instead of text-based user
interfaces;

• Monitor application software and tasks running using Task Manager program. It
also provides information about computer performance which includes running
processes, CPU load, and Windows services;

• Manage, repair and optimise the performance and data of the computer system
using a set of program called utilities programs; and

• Include basic features of the Windows OS, such as Desktop, Icons, Taskbar, Start
menu and Shortcuts.
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Some concepts of storage are as follows.

Random Access: It refers to the feature of accessing data randomly. This method can 
read or write information anywhere on the media/storage device. By using indexing, this 
type of operation directly accesses data, so it is also called direct access. An example of 
Random Access is RAM (Random Access Memory) in a computer.

Sequential Access: It means that the data on the computer system can be accessed 
sequentially. This method can read or write the information from the beginning of the file. 
Examples of Sequential Access are the Backup Tapes and Tape Drives.

When it comes to speed, Random Access can be a lot faster to access large databases. 
When it comes to data backup, Sequential Access is still in use because of its efficient 
storage method.

Volatile: In computer storage, volatile memory is a device which can store data only 
when it is powered. An example of Volatile Memory is RAM (Random Access Memory) 
in a computer.

Non-volatile: Opposite to Volatile, Non-volatile memory is the method of storing data 
permanently. It means, even if the computer is powered off, the data remain stored. An 
example of Non-volatile Memory is HDD (Hard Disk Drive) or SSD (Solid State Drive) 
in a computer. HDD is a mechanical device and it uses moving parts inside the device to 
read and write data. There is some friction loss when the moving parts operate, producing 
some noise when it is running. SSD does not have any moving parts so there is no data 
loss problem or drive corrupt problem. As such, SSD can read and write data without 
producing noise and can be more durable. In general, the read and write speed of SSD is 
higher than HDD; however, the former is usually more expensive than the latter.

In computer technology, volatile memory such as RAM is a lot faster to read and write 
than non-volatile memory such as HDD. In reality, data stored permanently in HDD are 
loaded to RAM for processing while the computer is running, for faster response in 
communicating with CPU (Central Processing Unit), as necessary. After the computer is 
turned off, the data will not remain in RAM. If one would like to keep the data, the data 
should be stored in HDD before having the computer turned off.
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Data Transfer Rate and Storage Capacity: In computer history, there are numerous 
types of storage technologies. In the early times, Vacuum Tubes were used. Nowadays, 
cloud storage technology is common. Over the time, the size and read/write speed of 
storage have dramatically increased.

Data Transfer Rate (DTR): Data transfer rate is the speed that data can be copied/moved 
from one location to another. It can be measured in bit per second (bps) and Byte per 
second (Bps).

Storage Capacity: Storage capacity is the size of how much data can be stored. It can be 
measure in bit or Byte.

1 Byte = 8 bits 
1 Kilobyte = 210 Bytes = 1024 Bytes ≈ 1000 Bytes 
1 Megabyte = 1,024 Kilobytes (or) roughly 1 Million Bytes 
1 Gigabyte = 1,024 Megabytes (or) roughly 1 Billion Bytes 
1 Terabyte = 1,024 Gigabytes (or) roughly 1 Trillion Bytes 
Kbps = Kilobits per second / KBps = Kilobytes per second 
Mbps = Megabits per second / MBps = Megabytes per second 
Gbps = Gigabits per second / GBps = Gigabytes per second

Figure 2.7. Storage capacity of data 
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Technology Data transfer rate Storage capacity Remarks

Selectron Tube N/A 256 to 4096 bits Vacuum Tube Technology

CD 150 KBps to 6 MBps 700 MB Optical Storage Technology

DVD 1.32 MBps to 21.13 MBps 4.7 GB to 17.08 GB Optical Storage Technology

HDD (3.5”) 50 MBps to 140 MBps 4 TB maximum (still improving) Magnetic Storage Technology

HDD (2.5”) 50 MBps to 140 MBps 2 TB maximum (still improving) Magnetic Storage Technology

SSD 200 MBps to 700 MBps 1 TB maximum (still improving) Integrated Circuit Storage 
Technology

Some types of storage media are shown below, indicating the differences in data 
transfer rate and storage capacity.
Table 2.2. 

Files and folders management

Understanding files and folders management is important in using a computer. 

Files: Digital version of resource or data stored in the computer system. There are different 
types of computer files, such as Microsoft Word documents, picture files, music / video 
files or computer program files. There are different applications software / computer 
programs to open these file types. 

Some common file types are as follows:

• Images: .jpg, .jpeg, .png, .gif, .bmp, .tif, .tiff;
• Audio: .mid, .midi, .mpa, .mp3, .wav, .wma;
• Video: .mp4, .mpg, .mpeg, .wmv, .avi, .mov;
• Word processing: .txt, .doc, .docx, .odt, .pdf;
• Spreadsheet and data: .xls, .xlsx, .ods, .mdb;
• Presentation: .ppt, .pptx, .pps, .odp;
• Compressed files: .zip, .rar, .7z;
• Executable files: .exe, .apk;
• Internet: .htm, .html, .xhtml; and
• E-books: .epub, .mobi.
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Folders: Cataloging structure of a directory in a file system which can put files inside. 
When a directory is inside another directory, it is called sub-directory.

Figure 2.8. 

In below figure (Figure 2.9.), Folder A is called Root Folder or Directory. The others 
are sub-directories. Folder B is called Parent folder for Folder C and Folder D while 
they are the Child folders. Similarly, Folder E is the Parent folder for Folder F.
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You can imagine that when there are a lot of files and folders in your computer, it may not 
be easy for you to locate the files or folders you want. As such, you should name the files 
and folders in a consistent, organised and descriptive way. Some more tips of naming files 
and folders are as follows:

• Ensure that the names can provide meaning for you to understand what is contained
in the files/folders;

• Keep the names not too long because long names may not work well with some
types of software;

• Use only letters and numbers and avoid using special characters such as @, #, $,
%, ! ,

• \, >, *, :, “ because these may not be readable by some types of software. No blank
space ( ) should be used for the names either;

• Use lowercase letters only or use capital letters only for the first letter of words if
possible for consistency purpose;

• If there is a need to indicate a date in the name, follow the format YYYYMMDD
(Y refers to Year; M refers to Month; D refers to Date) so that the files and folders
can be sorted in chronological order easily; and

• Use leading zeros (0) in the name if you number the files and folders in sequential
order. For instance, use 001, 002, 011, 012 instead of 1, 2, 11 and 12.

Figure 2.9. Folder structure

Folder A

Folder C Folder D Folder F

Folder B Folder E
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Learning activity 1

For each description about system software and application software, put a tick in the 
appropriate box to indicate whether the description is true or not. If needed, you can 
discuss your answers with your peers.

No. Description True False

1 System software can function independent of application software while application 
software cannot run without system software.

2 There are much fewer system software as compared to application software.

3 The programming of system software is relatively complex as it requires the knowledge 
of the working of the underlying hardware while the programming of application 
software is relatively easier as it requires only the knowledge of the underlying system 
software.

4 Application software executes continuously as long as the computer is in operation 
while system software executes only when the end user requires.

5 System software runs in the background and the end users usually do not interact with it 
directly; however, application software runs in the foreground with frequent interaction 
with the end users to satisfy their computing needs.

6 Examples of system software include Windows OS, Mac OS and Linux, Microsoft Word 
while examples of application software include Windows Media Player and Adobe 
Photoshop.

Learning activity 2

For each scenario below, choose a more appropriate storage medium to be used by ticking
the corresponding box and justify the use of one storage medium over the others. If you 
think there is another storage medium which is more appropriate, please write it down 
under the ‘Others’ option in the ‘Selected storage medium’ column.

1. I use a public computer in the library to prepare my lesson plan by creating word
processing files. Should I save my files using HDD in the public computer or a
USB flash drive?

Selected storage medium Justification of selection

‪	 HDD in the public computer
‪	 USB flash drive
‪	 Others: ____________________
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2. I need to save some important files containing student teachers’ final examination
scores in a safe place. Should I save the files using HDD in the head of
administration’s office laptop or a USB flash drive?

3. The Ministry of Education at the central level requests our college to save student
teachers’ personal information in a storage medium and to deliver the storage
medium to Nay Pyi Taw. Should I save the files using CD or DVD or a USB flash
drive?

Selected storage medium Justification of selection

‪	 CD
‪	 DVD
‪	 USB flash drive
‪	 Others: ____________________

Selected storage medium Justification of selection

‪	 HDD in the head of administration’s office laptop
‪	 USB flash drive
‪	 Others: ____________________

4. I want to purchase a laptop which I can carry around between my home and the
school. I will also need to bring it along with me when I travel to other places in
Myanmar. Should I choose a laptop with HDD or SSD?

Selected storage medium Justification of selection

‪	 HDD
‪	 SSD
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No. File name Acceptable or 
not?

If it is not acceptable, suggest anoth-
er file name.

1 myfile.doc Acceptable /
Not acceptable

2 20191203year1testscore.xls Acceptable /
Not acceptable

3 mYaNmArSoNg.wmv Acceptable /
Not acceptable

4 English-grammar-class-2.docx Acceptable /
Not acceptable

5 LessonPlanMaths@Year1.txt Acceptable /
Not acceptable

6 photo.jpg Acceptable /
Not acceptable

7 PRACTICUM_RECORD.odt Acceptable /
Not acceptable

8 Year_1_Semester_1_Reflective_
Practice_and_Essential_Skills_
Assignment_3_December_2019.ppt

Acceptable /
Not acceptable

9 ict textbook copy.pdf Acceptable /
Not acceptable

10 science-homework-final4-revised.html Acceptable /
Not acceptable

Learning activity 3

Comment on whether the following file names are acceptable following the tips you have 
learnt in Learning activity 1 by circling your choice. For those file names which you think 
not acceptable, suggest a better one.
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Yes No Not sure

2.1.1.

I can describe the structures and functions of hardware within a computer 
system (input, Central Processing Unit, output and storage).

I can describe the features, advantages, disadvantages and examples of 
input and output devices and select the appropriate use of devices in 
various scenarios.
2.1.2.

I can outline the developments in computer systems.

I can compare the characteristics of various types of computers.

2.1.3.

I understand functions of system software and applications software and 
describe the basic functions of an Operating System such as Windows.

I can describe the functional characteristics of storage devices in terms 
of random or sequential access, volatile or non-volatile, data transfer rate 
and storage capacity.
I understand file and folder management.

Review questions

1. Reflect on what you have learnt in the lessons under this unit and assess your
understanding of the subject.

2. What are the input and output devices that you think are useful for teaching and
learning in basic education schools?

3. Which type of computers would be useful in basic education schools? Please
justify your answer.

4. Why is file and folder management important? Give AT LEAST TWO examples
showing what you can do to ensure the management of proper records of files and
folders.
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Key messages

• A computer may be divided into several fundamental units: input, Central Processing
Unit and output.

• There are six generations of computers with recent development on Artificial
Intelligence and robotic technology. A generation indicates a major breakthrough,
such as reducing the size of processors as well as increasing capacity and speed.

• There are four types of computers, namely supercomputers, mainframe computers,
minicomputers, microcomputers and mobile computers. In our daily life,
microcomputers and mobile computers are commonly used in Education Colleges.

• Application software is a type of software designed for end-users to perform specific
user’s task, including those to support teaching and learning.

• It is important to understand what input, output and storage devices should be used
based on the need and purpose of the tasks.

• Proper file and folder management allows end-users to locate files or folders in the
computer easily.

Unit Summary
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	 1.	 How do you describe computers in your daily life?

	 2.	 How do you compare the various types of computers?

	 3.	 How can you do to ensure effective management of proper records of files and 
folders on the computers?

Unit reflection

Further reading

2.1.

Types of input devices with explanations: https://www.tutorialspoint.com/computer_
fundamentals/computer_input_devices.htm

Types of output devices with explanations: https://www.computerhope.com/jargon/o/
outputde.htm

The Evolution of Computers: https://www.nortonsecurityonline.com/security-center/
evolution-of-computers.html
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Basic ICT Literacy Training Manual: Developed by UNESCO, is available in E-Library.

Size / Bandwidth Calculator: http://www.stardot.com/bandwidth-and-storage-calculator

Basic Functions of an Operating System: https://www.techwalla.com/articles/what-are-
system-interrupts

Different types of computers: http://www.vidyagyaan.com/computer-knowledge/
different-types-of-computer/

Data Transfer Rate: https://searchunifiedcommunications.techtarget.com/definition/data-
transfer-rate
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Expected learning outcomes

By the end of this unit, you will be able to:

•	 Perform basic functions on an Operating System such as Windows; 
•	 Install fonts onto the system and demonstrate typing; and
•	 Describe and practise the basic functions of word processing such as Microsoft 

Word (typing in Myanmar font (Zawgyi and Unicode), page setup, saving, 
formatting, printing, header and footer, bullets and numbering; creating tables, 
inserting pictures and charts).

Computer 
Application 
(Word processing)

Unit
3

In previous unit, you have learned the development of computer systems, functions of 
hardware within a computer system and functions of the system software such as Operating 
System. In this unit, you will be able to learn the basic functions of the Operating System 
such as Windows and practise the basic functions of word processing application such as 
Microsoft Word including typing in Myanmar fonts (Zawgyi and Unicode).
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In this sub-unit, you will learn how to perform basic functions of an Operating System 
and installing fonts onto the system and demonstrating typing.

By the end of the lesson, you will be able to:

•	 Perform basic functions on an Operating System such as Windows.

Expected learning outcomes

3.1.1.
Performing Windows basic functions

3.1. Basic Functions and 

Troubleshooting
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Mouse clicking in Windows Operating System

Mouse has two buttons (Left and Right), which has different functions, and in the middle 
there is usually a scroll wheel which can go up and down to control the menu/scroll bar.

Left Click: By default, it is used to select one item by pointing and clicking. You may 
also select many items by holding the left button and drag the pointer. It is generally used 
more frequently than the Right Click button and sometime it is used for performing other 
functions on an application software, such as placing the cursor in a Word Processing 
software.

Right Click: By default, it is used to show a pull-down menu with a list of the functions 
for you to click and select.

Logging in

You will see the welcome screen 
as soon as you open a computer 
which has Windows installed. 
Click on the user account to log 
into the Windows. You might 
need to enter password if the user 
account was set with a password. 

Logging off	

You can log off from an account by 
clicking Sign Out button as shown in the 
below figure so that you can log in to 
another user account.

Figure 3.1. Login screen 

Figure 3.2. How to sign out on Windows
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Interface of the Windows Operating System 

Below is the Windows desktop you see will after logging in. One of the most important 
parts of your Desktop is the Taskbar and Pin Icons to it. By default, it is located at the 
bottom of your screen giving you access to the Start Menu which include Power Button 
and Setting, several application icons, Search and the Notification Area.

When you open an application, the windows of the application will pop up and you will 
always see three buttons at the upper right corner.  They are Minimize, Maximize and 
Close buttons.

1. Minimize button is to hide the windows in the Taskbar.
2. Maximize button is to view the windows in full-screen size.

Restore down button is to restore the windows the state before changing full-
screen size.

3. Close button is to close the currently opened windows.

Figure 3.3. Windows desktop

Figure 3.4.

1 2 3
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Creating shortcuts

Shortcuts can be created by the following steps: 

Step 1: Right click over an empty space and right-click on desktop.

Step 2: In the menu, select New and then click Shortcut.

Step 3: On the Create Shortcut window, you can either Browse or type the location of the 
item you want to access. Then, select the location and click OK. 

Figure 3.5.

You can move the windows by clicking on its title bar on the upper side, drag and drop 
it in a new place. Moreover, you can resize the windows by pointing your mouse at any 
corner of the windows until a double-sided arrow appear, click and drag until you get your 
preferable size.

Below show the desktop icons which are a graphic representation of an application or a 
file. You can rearrange and resize the icons by right click on the desktop > New> choose 
the options (large icons, Medium icons, small icons, Auto arrange icons, Align icons 
to grid. You can also hide the desktop icon by clicking (uncheck) Show desktop icons.
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Step 4: After choosing it, you can assign or change the name with which the shortcut will 
be identified. After making any changes, click Finish.

Step 5: After clicking Finish, you will then see the shortcut icon in your Desktop.

Start menu

The Start Menu is the main point of access to your applications. There are three common 
ways to open it:

Method 1: Use your mouse to click Windows icon in the lower-left corner of the taskbar.

Figure 3.6.
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Method 2: Press the Windows key on your keyboard.

Method 3: Press Ctrl + Esc keys on your keyboard.

Figure 3.8.

Figure 3.9.

Search

The Search box on the Taskbar will allow you to search within your documents and files 
or on the Web for anything you write. The initial results will appear within the Start Menu 
itself. The results will be grouped according to the closest match (or matches) labeled 
Best match at the top of the list.

Figure 3.7.
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Shortcuts and Keyboard Shortcuts 

A shortcut is simply an icon that directs you to an item (a document, application, or picture) 
that is located somewhere else in your computer. Like most Windows applications, there 
are several keyboard shortcuts you can use to make it easier or faster for some to perform 
certain tasks. Most of the new Windows shortcuts use the Windows key (  ) combined 
with other keys to perform several actions. The following are some of the useful shortcuts.

Table 3.1.

Shortcut Action

Windows key  Open the Start menu

Windows key  + S Open the Windows Search

Windows key  + C Open Cortana

Windows key  + Tab Open Task View

Windows key  + D Show or Hide the Desktop

Windows key  + L Lock your account

Windows key  + A Open the Action Center sidebar

Windows key + I Open the Settings window

Windows key + E Open the File Explorer window

Windows key + Print Screen Takes a screenshot of your whole display and stores it in Pictures > Screenshots

Windows key + space bar  Open language bar 

Windows key + R  Open run box

Windows key + P  Open display switcher

Windows key + K Open Wireless Connection
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Basic management of files and folders using Microsoft Windows

You can view and organise files and folders. This can be done using Explorer (which is 
also called File Explorer or Windows Explorer).

Opening a file or folder is simply double-clicking the file or Right click and select Open.
Right click and select Rename from the menu, to rename a file or folder.

You can create New Folder by Right click on the Explorer or Desktop and on the menu 
appeared, Select New -> Folder. Or on the File Explorer, select the New Folder button. 

If you want to create New File, Right click on the Explorer or Desktop and on the menu 
appeared, Select New -> Select the file type you want to create (For example, Microsoft 
Word Document).

Moving a file into folder or moving a folder into another folder is easy. You just need to 
Click and Hold (left button of the mouse) onto the desire file / folder, drag it to the desire 
location.

Figure 3.10.
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If you want to delete a file or folder, you can do one of the following instructions.

• Select the file or folder, and press delete key from the keyboard.
• Select the file or folder, Right click and select Delete from the menu appeared.
• Click and Hold (left button of the mouse) onto the desire file / folder, drag it to the

Recycle Bin.

By doing one of the above instructions, the file or folder deleted will be moved to Recycle 
Bin and you can restore the files to the original location by opening Recycle Bin, Select 
the desire file or folder to restore, Right click and choose Restore.

If you want to delete the files / folders from the Recycle Bin permanently, you can Right 
click the Recycle Bin and select Empty Recycle Bin. Please note that, you can delete a file 
or folder permanently without moving to the Recycle Bin by selecting the item, press 
holding the Shift key and press Delete key from the Keyboard. It will delete the file or 
folder permanently.

Learning activity 1

You are supposed to finish reading about the lesson and do individual practice for 
class. This activity is to be completed in class by completing the following step by step 
instructions. Consult your teacher educator if you find any difficulties.

Task 1

Practise to answer and perform the following tasks on a computer.

1. How to show and hide desktop icons?
2. Which shortcut key can be used to open the ‘Start Menu’?
3. Pin Microsoft Word and Microsoft Excel in the taskbar.
4. Unpin Microsoft Excel from the taskbar.
5. Which shortcut key can be used to lock your account?
6. Create a shortcut file with your name on desktop.
7. Open an application, minimise the windows, restore it, resize it and close it.
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Learning activity 2

In group, share one problem each on using Windows and discuss possible solutions. Two 
examples of common problems are given below.

Common problems using 
Windows Possible solution / suggestion

A file is accidentally deleted and 
needs to be recovered.

I know my file name but forget where 
I have saved it in the File Explorer.

Task 2

Practise to perform the following tasks on a computer.

Step 1: Create one Microsoft Word Document file and name it as ‘Lesson 3.1.1.’. Create 
one folder and as it as ‘EC ICT Curriculum’.
Step 2: Rename the file with your name and folder as ‘Activity 2’.
Step 3: Move the file inside the folder. Temporarily delete both file and folder. 
Step 4: Restore the file and folder. Do the permanent deletion of the file and folder.
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What is font? 

In the computer system, font is the printable or displayable text character in specific style 
and size. It is also called typeface. There are many type of fonts with different styles and 
designs of the alphabets, such as Times New Roman, Arial and Calibri. These fonts are 
already installed into the commonly used Operating System such as Microsoft Windows.

There is a standard that defines how text should be saved into data and how it is read and 
written, and it is called Unicode. Before Unicode, there were many different character 
encoding systems, which could cause character encoding to be conflicted with one another 
as the Operating System might not be able to read and understand different character 
encoding.

Myanmar fonts

In Myanmar, there are two main types of character encoding system which is commonly 
seen. Zawgyi font is a typeface used for Myanmar language text on websites, also known 
as Zawgyi-One or zawgyi1 font. It is the most popular font on Myanmar websites and 
widely used among Myanmar people. Although some of the code-points are similar to 
Myanmar Unicode, it is not compatible with Unicode. In order to use Zawgyi Font, you 
will need to install the font and a keyboard layout into the Operating System.

Myanmar Unicode is another typeface with Myanmar characters, which follows 
internationally accepted standards by the World Wide Web Consortium. Myanmar 
Unicode font, sometimes known as Myanmar2/Myanmar3, is gaining its popularity in 
Myanmar and is pre-installed in commonly used Operating System such as Microsoft 
Windows 8 or above. The latest version of Myanmar Unicode family is Pyidaungsu font.

By the end of the lesson, you will be able to:

• Install fonts onto the system and demonstrate typing.

Expected learning outcomes

3.1.2.
Installing fonts onto an Operating System

Year 1 Semester 1 - EDU1109 - Curriculum and Pedagogy Studies: Information and Communication Technology



Year 1 Semester 1 - EDU1109 - Curriculum and Pedagogy Studies: Information and Communication Technology

Student Teacher Textbook 73

Installing the font into the Windows system

To install any font into the Windows system, you may follow the procedures below:
Step 1: Download the font file from the Internet.
Step 2: Copy the downloaded font file into Font folder. (or)
Alternate Step 2: Right click on the font file and Click ‘Install font’.

Keyboard layout

A typical keyboard displays the English alphabets, which you can type on each stroke. 
The most commonly used keyboard layout is ‘QWERTY’ keyboard, called based on the 
few keys on the top row of letters. It is important to familiarise yourself with the keyboard 
layout so that you can practise typing.

Step 1: Take a good look to the Keyboard layout. You will find the function keys such as 
Caps Lock, Shift, Backspace, Delete, Esc (Escape), and so on. There are also letter keys. 
You can put your fingers as shown in Figure 5.1.

Step 2: Try typing something in a word processing application such as Microsoft Word in 
capital letters and small letters. You can try pressing at the same time ‘Shift + a alphabet 
key’ or pressing ‘Caps Lock’ and then any alphabet key to see the letter transformation 
between upper-case and lower-case.

Step 3: Try using different fonts. There are many fonts which are different in styles. Typing 
in Myanmar font is different whereas the key placing is not the same even between two 
popular Myanmar typefaces, Zawgyi and Unicode fonts. You can find in Figures 5.2 and 
5.3 below the keyboard layout for these fonts.

Step 4: Try using Function keys. Try erasing the letters you have typed by using 
‘Backspace’ and ‘Delete’ function keys. You can also combine the Function key(s) and 
letter key(s) to use as shortcut keys or activation of certain functions. For instance, type 
at the same time ‘Ctrl + F’ to launch a Find window to search for documents by keywords 
in your computer.
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Myanmar Language Keyboard (Unicode)

Myanmar Unicode Typing includes built-in in the Windows 10. In other words, there is no 
need to install Unicode in Windows 10. But you need to add Unicode Myanmar keyboard 
in Language settings. To add it, you can do the following steps.

Step 1: Type ‘Control Panel’ in the search bar and then open Control Panel.
Step 2: After opening control panel, choose Language.
Step 3: And then, choose Add a language.
Step 4: After clicking Add a language, choose ျမန္မာစာ and then click Add.
Step 5: After clicking Add, it added Unicode Myanmar keyboard in Language settings.

Keyboard Function Keys/Short-
cuts Action

F1 Universal Help in almost every Windows program.

F5 Refresh or reload the page or document window.

Alt + F File menu options in current program.

Alt + Tab Switch between open apps.

Ctrl + A Select all.

Ctrl + C Copy selected item.

Ctrl + End Goes to end of document.

Ctrl + Esc Open the Start Menu.

Ctrl + Home Goes to beginning of document.

Ctrl + Ins Copy selected item.

Ctrl + Shift + F Change the font.

Ctrl + V Paste selected or Cut item.

Ctrl + X Cut

Ctrl + Z Undo last action.

End Goes to end of current line.

Home Goes to beginning of current line.

Shift + Del Cut selected item.

Shift + End Highlights from current position to end of line.

Shift + Home Highlights from current position to beginning of line.

Table 3.2.
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To use Myanmar font, you need to change keyboard settings. To change it, click keyboard 
icon    on the taskbar and then choose MY Burmese (Myanmar). Another way is 
that you can use Ctrl + Shift key from keyboard to also change keyboard settings.

For example - To type ‘ျမန္မာ’, you need to type ‘j r e f r m’.

Figure 3.11.	 Hand position on a QWERTY keyboard

Figure 3.12.	 A keyboard layout for typing Zawgyi font

Shift+key

Ctrl + Alt + Shift + 
Key (or) 

Shift + Tide + -> key

Ctrl + Alt + key
(or)

Tide -> key

key alone

Z
အျပာေရာင္စာလံုးမ်ား ေပၚလာမည္မဟုတ္ဘဲ( Shift ကဲ့သုိ႔ တြဲရိုက္ရျခင္းမဟုတ္)
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Figure 3.13.	 A keyboard layout for typing Unicode font

သဏၭာန္
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Figure 3.14.	 A keyboard layout for typing Pyidaungsu font

သဏၭာန္
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Yes No Not sure

3.1.1.

I can perform basic functions on an Operating System such as 
Windows.

3.1.2.

I can install fonts onto the system and demonstrate typing.

Review questions

1. Reflect on what you have learnt in the lessons under this unit and assess your
understanding of the subject.

2. What is an Operating System? How is it useful for your daily work?
3. Which Myanmar font do you think would be the most suitable for Myanmar basic

education schools? Justify your answer.
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A word processing application, or known as a word processor, allows you to perform 
different tasks of composing, editing, formatting and printing of a wide variety of 
documents, including letters, resumes and reports. It is a useful aid for teaching and 
learning as well because you may use it to create lesson plans, worksheets and examination 
papers. Moreover, the produced materials by word processing are easy to share among 
teachers and students. Education staff can also prepare official letters and other office 
documents for administrative purposes using a word processing application. 

A word processing application is one of the most frequently used software programmes 
on a computer. Microsoft Word is the most popular but commercial one. Examples of 
free word processing application are LibreOffice, Open Office and Google Docs. While 
many of the word processing applications have similar functions, it is important to know 
which application your counterparts usually use because it is advisable to use the same 
word processing application for document sharing to avoid any loss in formatting. For 
instance, if you create a document using LibreOffice and share it with a friend who will 
use Microsoft Word to open it, the formatting of the document may be slightly changed.

Be aware of the difference between a word processing application and a plaintext 
editor. The former can perform formatting tasks while the latter, such as Notepad on the 
Windows Operating System, can only allow editing and creating plain text documents 
without any formatting capabilities. A word processing application offers a number of 
additional features that can make your text document with a more professional appearance. 
However, if you need more design features of a document, you may need to use a desktop 
publishing software, such as Microsoft Publisher or Adobe InDesign, which can give you 
more control over the page layout.

In this unit, you will learn how to navigate the commonly used Microsoft Word interface 
and become familiar with its most important features, such as the Ribbon, Quick Access 
Toolbars, and Backstage view and Myanmar font typing.

3.2. Word Processing
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By the end of the lesson, you will be able to:

• Describe the basic features of a word processing application;
• Create, open, view, save and close a new document; and
• Type Myanmar font (Zawgyi and Unicode) in word document.

Expected learning outcomes

3.2.1.
Basic functions of word processing 1

Starting the Microsoft Word

Here is more than one way to start the Microsoft Word. The following are three methods 
that you can start the Microsoft Word. 

Method 1 
Step 1: Click Start Button on the Windows taskbar. Start Menu will display. 

Step 2: Point on All Programs and click on Microsoft Word application (for example, 
Word 2016).   

Figure 3.15.
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Method 2 

Step 1: In the Search box, type the name of Microsoft Word application (e.g. Word2016)

Step 2: Click on Microsoft Word application (e.g. Word 2016).

Method 3 

Step 1: Hold the window key   and press r in keyboard.
Step 2: Type ‘winword’ in run box. 
Step 3: Click OK or press Enter key. 

The following screen will appear as soon as a Microsoft Word window is opened. You may 
explore how each feature work. You may also see the screencasts of detail explanation of 
some important features.

Figure 3.16. Opening a Microsoft Word window
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Figure 3.17. Microsoft Word 2016 screen

File Tab

Tabs

Title Bar

Scroll Bar

Status Bar View Zoom Slider

Windows

Ribbon

Collapase RibbonDialog Box Launcher

Document Window

Ruler

Group

Quick Access

Tab Setting

Creating a new document

Step 1: Click New in File Tab

Step 2: Double click on ‘Blank 
Paper or a template’ 

1

2

Figure 3.18. Microsoft Word 2016 Open 
New File screen
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Saving a document 

Step 1: Click Save (or) Save as in File tab.

Step 2: Click browse to find the location to save.

Step 3: Choose the location where you want to save the document. For example, click 
Desktop.

Step 4: Type your name in the file name box.

Step 5: Choose word document in the save as type.

Step 6: Click Save. You will see the Microsoft Word file with your name on Desktop 
Screen. 

			   Learning activity 1

Prior to the lesson, create a new word document and, in the blank document, type the 
following first paragraph in Myanmar Zawgyi and type the second paragraph in Myanmar 
Unicode. Save your file with a meaningful file name.

Type the following in Myanmar Zawgyi:

	 သံုးစဲြသူမ်ား၏ အလုပ္တစ္ခု သို႔မဟုတ္ အလုပ္မ်ားကို ၿပီးေျမာက္ေစရန္ကူညီေပးသည္။ ၎တြင္ စာစီစာ႐ုိက္ျခင္း၊ 

အင္တာနက္ၾကည့္႐ႈျခင္းႏွင့္ အျခားလုပ္ငန္းကိစၥမ်ားအတြက္ Software မ်ားကိုသြင္းယူထားရမည္။ အခ်ဳိ႕ေသာ 

Application Software မ်ားကို ကြန္ပ်ဴတာစနစ္ႏွင့္အတူ ႀကိဳတင္သြင္းယူထားသည္။ Software ကို ေယဘုယ်အားျဖင့္ 

လူပုဂၢိဳလ္မ်ားအလြယ္တကူဖတ္ႏိုင္ေသာ အဆင့္ျမင့္ Program ေရးသားနည္း (High-Level Programming Language) 

ျဖင့္ေရးသားထားၾကသည္။ ၎(High-Level) ၫႊန္ၾကားခ်က္မ်ားမွ ကြန္ပ်ဴတာ နားလည္သည့္ဘာသာစကား (Machine 

Language) သို႔မဟုတ္ ႏွစ္ခုစံုသေကၤတ (Binary Code) အျဖစ္ Hardware မ်ားလုပ္ေဆာင္ႏိုင္ရန္ ေျပာင္းလဲေပးသည္။ 

ကြန္ပ်ဴတာနားလည္သည့္ ဘာသာစကား (Machine Language) သည္ Software မ်ားသြင္းယူစဥ္ကတည္းက ပါဝင္လာ 

သည္။
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			   Learning activity 2

In class, discuss the difficulties found during the individual practice and find the solutions 
together with the guidance of your teacher educator.

Common Problems using Microsoft 
Word Possible Solution / Suggestion

Type the following in Myanmar Unicode:
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Learning activity 3

This activity is to be completed after class. Produce a Word document using Myanmar 
Unicode font as shown in the sample below and save it with the file name as ‘Activity 
3.2.1._[Add Your Name Here]’ in your computer. Please make sure to back up your file in 
your own USB flash drive (if any). 
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By the end of the lesson, you will be able to:

• Do text, paragraph and table formatting;
• Create document designs and layout; and
• Print a document.

Expected learning outcomes

3.2.2.
Basic functions of word processing 2

Text and paragraph formatting 

You are to be working under Home tab to do text and paragraph formatting.

Copying text

Step 1: Type some text in the blank document, select the text by clicking and drag from 
the beginning to the end of the text. 

Step 2: Click Copy in Clipboard group (or) press (Ctrl + c) at the same time in keyboard. 

Step 3: Place the cursor in new location and click Paste in Clipboard group (or) press 
(Ctrl + v) at the same time in keyboard. 

Clipboard
Group

Paragraph Group Style Group Editing Group

Font Group

Figure 3.19.
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Customising font

Step 1: Select the text by clicking and drag from the beginning to the end of the text.

Step 2: Choose the font type, style, size, color, highlight color in the Font group (ctrl + 
r) (or) Click custom arrow  in Font Group to open Font Dialog box where you can 
choose more options to customise your text in advanced setting.  

Please format the text as follows: 

Font type = Monotype Corsiva
Font size = 18
Font color = Grey
Bold and underline 
Capitalise each word
Double strikethrough

Moving text

Step 1: Type some text in the blank document, select the text by clicking and drag from 
the beginning to the end of the text. 

Step 2: Click Cut in Clipboard group (or) press (Ctrl + x) at the same time in keyboard. 

Step 3: Place the cursor in new location and click Paste in Clipboard group (or) press 
(Ctrl + v) at the same time in keyboard. 

Copying Format

Step 1: Select a word (or) a shape that has been formatted.

Step 2: Click Format Painter    in Clipboard group (or) double click 
Format Painter to apply the format in multiple places. The cursor will change into Format 
Painter form.

Step 3: Place the cursor on another word/shape you want to apply the format.

A sample answer is shown below:

Myanmar Educational Colleges
21st Century Skills, H2O
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Customising paragraph

Step 1: Type one paragraph (or) copy and paste the previous text into one paragraph, 
select the text by clicking and drag from the beginning to the end of the paragraph.  

Step 2: Choose the alignment, line space, indent, sort, paragraph mark, shading, border in 
the Paragraph group (or) Click custom arrow  in Paragraph Group to open Paragraph 
Dialog box where you can choose more options to customise your paragraph in advanced 
setting.

Figure 3.20.

Left	 : Align text to the left

Center  	 : Align text to the center

Right     	 : Align text to the right

Justify   	 : Align text to both left and right margins

Line Spacing  	 : Space between each line within a paragraph

Bullets 	 : Create a bullets list from scratch

Numbering   	 : Create a numbered list from scratch

Decrease indent   : Move closer to margin

Increase indent   : Move farther away from margin

Sort  	 : Arrange the line in alphabetical (or) numerical order

Paragraph Mark  : Show/Hide paragraph mark 

Shading  	 : Highlight the paragraph 

Borders    	 : Add/ Remove the border of paragraph 
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Editing [screencasts link to be added]

• To find or replace the words,
Step 1: Type one paragraph (or) copy and paste the previous text into one paragraph.

Step 2: Click Find or Replace in Editing group, type the word you want to find in  
the box next to find what, type the word you want to replace in the box next to  

		  replace with. 

Step 3: Click Replace to change one by one, Replace All to change all the word  
you find, Find Next to skip changing the current word, Cancel to withdraw finding  
and replacing. 

• To quickly go to a specific place within a document,

Step 1: Click on dropdown arrow of Find   and click Go to.

Step 2: Under Go to what, choose the Page if you want to go to a specific page. 

Step 3: Type the page number you want to go (e.g. 3) under Enter page number  
		  and click Go To.  

Figure 3.21.
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Table creating and formatting

You will be working in Insert tab to create a table. 

Figure 3.22.

Pages
Group

Tables
Group

Add-in s
Group

Links
Group

Symbols
Group

Header & Footer
Group

Illustration
Group

Media
Group

Comments
Group

Text
Group

Flash
Group

Creating Table [screencast link to be added]

There are three methods to create table. 

Method 1 

Step 1: Place the cursor where you want to insert table. 

Step 2: Click drop down arrow in table group in Insert tab. 

Step 3: Select number of row and column and click. 

Method 2

Step 1: Place the cursor where you want to insert table.

Step 2: Click Insert Table in table group in insert tab. Table Dialog Box will appear in 
the document.

Step 3: Select Number of columns and Number of rows in Insert Table Box and click 
OK. 
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Method 3

Step 1: Click Draw Table in table group in insert tab. 

Step 2: A pencil tool appears and draw the table, columns, rows by dragging and dropping. 

Modifying Table [screencast link to be added]

A table can be modified in Design tab and Layout tab. 

Figure 3.23. Groups under Design tab under Table Tools

Table Styles 
Options Group

Table Styles 
Group

Borders Group

Draw Group

Table Group Rows & 
Column Group

Cell Size 
Group Data Group

Merge Group Alignment
Group

Figure 3.24. Groups under Layout tab under Table Tools
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• To add more columns and rows in an existing table,

Step 1: Place cursor in the table.

Step 2: Select insert above/insert below/insert left/insert right in rows and
columns group in layout tab.

Note: you can click Draw Table button to draw table or Eraser button to delete
border of table in Draw group in Layout tab.

• To delete cell, column, row, table,

Step 1: Select (or) place cursor in cell/column/row/table you want to delete.

Step 2: Click drop down arrow of Delete in rows and columns group in Layout tab.

Step 3: Click Delete Cells/Delete Columns/ Delete Rows/Delete Table.

• To merge cells of a table,

Step 1: Select cells you want to merge.

Step 2: Click Merge Cells in Merge group in Layout tab.

• To Split cells of a table,

Step 1: Place cursor

Step 2: Click Split Cells in Merge group in Layout tab, set the number of rows and
columns you want to split.

• To split tables,

Step 1: Place cursor in the cell where you want to split the table.

Step 2: Click Split Table in Merge group in Layout tab.
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• To adjust text positions in table,

Step 1: Select the text in table cells.

Step 2: In Alignment group in layout tab, click Text Direction and choose your  
preferred alignment top left/ top center/top right/ center left/ center/ center right/  
bottom left/ bottom center/ bottom right.

• To modify table cells,

Step 1: Place cursor in the selected cell (or) select all cells you want to modify.

Step 2: Click Drop down arrow of Shading button in Design tab and click on the  
color you prefer. 

• To change table border style,

Step 1: In Design tab, choose line style, line weight, pen color. 

Step 2: Pencil tool will appear and click on the table borders you want to change. 

Document design and layout

You will learn commonly used functions for document design and layout. You will be 
working in Design tab and layout tab to do edit a document design and set the layout. 

Figure 3.25. Design tab

Document Formatting Group Page Background Group
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Formatting page background [screencast link to be added]

• To add watermark,

Step 1: Click dropdown arrow of Watermark  .

Step 2: Click on an available watermark with text to apply immediately (or) Click

Custom Watermark for more options and continue step 3.

Step 3: Select the radio button of Picture watermark and search for picture stored

in computer (or) select the radio button of Text watermark and type the letter you

want in Text box, choose font, size, color and layout of the text.

Step 4: Click Apply to confirm (or) click Cancel for not applying.

Note: After applying a watermark, you can cancel by clicking Remove Watermark.

• To add page color,

Step 1: Click dropdown arrow of Page Color  .

Step 2: Click on a color you prefer (or) click more color for More options (or)

click Fill effects to add gradient, texture, pattern, and picture as page background.

• To add page borders,

Step 1: Click Page Border  .

Step 2: Choose border style, color, with, and art.

Step 3: Under Apply to, choose where you want to apply the border in the

document.

Step 4: Click OK to confirm (or) click Cancel for not applying.

Figure 3.26. Layout Tab

Page Setup Group Paragraph Group Arrange Group
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Working with graphics

You will be working in Insert tab to insert pictures, shapes, smartarts, charts, wordart, 
drop cap, symbols.

ii) Page setup [screencast link to be added]

• To set page margin,

Step 1: Click dropdown arrow of Margins  .

Step 2: Select normal (or) moderate (or) wide which are commonly used.

• To choose page orientation,

Step 1: Click dropdown arrow of Orientation  .

Step 2: Choose portrait (or) landscape.

• To choose size,

Step 1: Click dropdown arrow of Size  .

Step 2: Choose the paper size you prefer. Letter, A4 and A3 sizes are commonly used.

• To set columns,

Step 1: Click dropdown arrow of

Step 2: Choose the number of columns you want which are one, two, three, left
right (or) click More columns for more options.

Figure 3.27.
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You will be working in Format tabs to modify pictures, shapes, smartarts, charts, wordart, 
drop cap, symbols.

Figure 3.28.

Adjust Group Picture Styles Group Arrange Group Size Group

Figure 3.29.

Insert Shapes
Group

Shape Styles
Group

WordArt Styles
Group Text Group Arrange 

Group Size Group

Pictures [screencast link to be added]

• To insert picture,

Step 1: In Insert tab, click Pictures    in Illustrations group.

Step 2: Find and click on your preferred picture, click Insert.

• To modify picture,

Step 1: Click on picture that you inserted in the document.

Step 2: In Format tab, you can adjust picture color, remove background of
picture, add effects, choose the frame, change layout, position and rearranging,
crop/resize the picture.
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Shapes  [screencast link to be added]

	 •	 To draw shape, 

		  Step 1: In Insert tab, click dropdown arrow of Shapes   in Illustrations group.  

		  Step 2: Choose your preferred shape and draw by diagonal dragging with mouse.

		  Step 3: Select the shape you draw.

	 •	 To modify shape,

		  Step 1: Click on a shape that has been drawn. 

		  Step 2: In Format tab, you can insert new shapes, fill the color inside shape,  
	 choose outline style, change effects, edit the alignment of text inside shape, choose  
	 the position of shape and its arrangement, resize shape.  

		  (Note: some groups in Format tab to modify shape will be different from format  
	 tab to modify picture) 

SmartArt   [screencast link to be added]

	 •	 To insert smartart,

		  Step 1: In Insert tab, click SmartArt    in Illustrations group.   

		  Step 2: Choose a SmartArt graphic you like and click OK.

	 •	 To modify smartart,

		  Step 1: Click on a smartart you want to edit in the document.

		  Step 2: In Format tab, you can modify the smartart as modifying a shape. 

		  Step 3: In Design tab, you can add more shapes, open text page to type, rearrange,  
	 choose color and layout. 
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Chart   [screencast link to be added]

	 •	 To insert chart,

		  Step 1: In Insert tab, click Chart    in Illustrations group.   

		  Step 2: Choose a chart you like and click OK.
	
		  Step 3: Select the chart you inserted, you can modify its type, style, layout, color  

	 in Design group and Format group.

	 •	 To modify chart,

		  Step 1: Click on the chart you inserted.

		  Step 2: In Format  tab, you can select the format of chart in Current Selection  
	 group and further modifications can be done.

		  Step 3: In Design tab, you can add element of chart, change layout, change color,  
	 choose chart styles, select and edit data, change chart type. 

WordArt   [screencast link to be added]

	 •	 To apply wordart, 

		  Step 1: In Insert tab, click dropdown arrow of WordArt   in Illustrations group.

		  Step 2: Choose your preferred wordart style and type the word in the textbox. 

	 •	 To modify wordart, 

		  Step 1: Click on the text which is in wordart format.

		  Step 2: You can do modification as you did to modify shape in Format tab. 
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Printing a document [screencast link to be added]

Step 1. Click File Tab.

1

Figure 3.30.

Drop Cap [screencast link to be added]

• To apply drop cap,

Step 1: Select the word you want to apply drop cap.

Step 2: Click dropdown arrow of Drop Cap   in Text group, and choose
Dropped (or) In margin. Click Drop Cap Options to choose font, number of
lines to drop, and distance from the text.

Symbols [screencast link to be added]

• To add symbol,

Step 1: In Insert tab, click dropdown arrow of Symbol   in Symbols group.

Step 2: Click More Symbols for more options.

Step 3: You can change font in Font box and choose an option in Subset box.

Step 4: Click on the symbol you prefer and click Insert to confirm or Cancel not
to add the symbol.
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Step 2. Choose ‘Print’ (or) press ‘Crtl+P’ in keyboard.

Step 3. Click drop down arrow under ‘Printer’ and choose the available printer 
name.

Step 4. Choose printing options under ‘Settings’. 

• You will see a preview of the document displayed in the right side of the window.

• Print the entire document (or) the current page (or) a range of pages.

• Print one side (or) both sides.

• Set page layout, such as page orientation, paper size, margins and number of page
per subject.

Step 5. Click Print button   to print the document.

Figure 3.31.

2
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Learning activity 1

In class, discuss the difficulties found during individual practise and find the solution 
together with the guidance of teacher educators and print the document (‘Activity 1_ 
[your name]’) that you save during self-practice in activity 1 if a printer is available.

Common problems using Microsoft 
Word Possible solution / suggestion
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Learning activity 2

Produce a Word document as shown in the sample below and save it with the file name as 
‘Activity 2_ [Add Your Name Here]’.  Your teacher educator will provide the instruction 
how and when to submit it. 

Figure 3.32.
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By the end of the lesson, you will be able to:

• Describe and practise the basic functions of word processing such as Microsoft
Word (typing in Myanmar font (Zawgyi and Unicode), page setup, saving,
formatting, printing, header and footer, bullets and numbering; creating tables,
inserting pictures and charts).

Expected learning outcomes

3.2.3.
Basic functions of word processing 3

This lesson emphasises on extra practising all the basic functions of word processing. In 
the previous lessons, you have learnt how to navigate the commonly used Microsoft Word 
interface and become familiar with its basic functions. In this lesson, you have to revisit 
those features practically and apply the skills in the educational context.

Learning activity 1

Before class, do the revision and practise the tasks that you have learnt in the previous 
lessons about word processing in group. Please take note of the parts that you are still 
unclear or need clarification.

In class, discuss the difficulties f ound d uring t he r evision o f p revious l essons i n your 
group.

Common problems using Microsoft 
Word Possible solution / suggestion
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Learning activity 2

Task 1

Create a word document following the sample below with the guidance of the teacher 
educator and print the document if a printer is available. Save the document as ‘Lesson 
3.2.3_Activity 2_Task 1_ [your name]’. 

Application software

Allow users to accomplish one or more tasks. It includes:

word processing;
web browsing; and
almost any other task for which you might install software.

Some application software is pre-installed on most computer systems. Software is 
generally created (written) in a high-level programming language, one that is readable by 
people. These high-level instructions are converted into ‘machine language’ instructions, 
represented in binary code, before the hardware can ‘run the code’. When you install 
software, it is generally already in this machine language, binary, form.

Figure 3.33.
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Task 2

Produce a Word document as shown in the sample below and save it with the file name as 
‘Lesson 3.2.3_ Activity 2_Task 2_ [Add Your Name Here]’.
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Task 3

Create a lesson plan template using Microsoft Word. You can make reference to the lesson 
plan you created for other subjects or a sample lesson plan from others in hard copy. Save 
the file as ‘Lesson: 3.2.3._Activity 3_ [your name]’. Your teacher educator will provide 
the instructions on how and when to submit your assignment.

Review questions 

1. Reflect on what you have learnt in the lessons under this unit and assess your
understanding of the subject.

Yes No Not sure

I can describe and practise the basic functions of word processing such 
as Microsoft Word (typing in Myanmar fonts (Zawgyi and Unicode), 
page setup, saving, formatting, printing, header and footer, bullets and 
numbering, creating tables, inserting pictures and charts).
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			   Key messages

•	 In Myanmar, there are two main types of character encoding system which is commonly 
seen. Compared to Zawgyi, Unicode follows internationally accepted standards and is 
gaining its popularity in Myanmar. The latest version of Myanmar Unicode family is 
Pyidaungsu font.

•	 A word processing application, or known as a word processor, allows you to perform 
different tasks of composing, editing, formatting and printing of a wide variety of 
documents.

Unit Summary

1.	 How will you make good use of Myanmar font typing skill in teaching and learning? 

2.	 How can you apply the skills of utilising a word processing application when you 
work as a teacher in basic education schools? 

3.	 If you are asked to install Myanmar font into a computer, what are the steps you would 
take to do it?

4.	 How would a word processing application be useful to plan your lesson? 

Unit reflection
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Further reading

3.1.

Windows Basics. (n.d.). https://edu.gcfglobal.org/en/windowsbasics/

Windows 10 Functions. (n.d.). Retrieved from https://www.extension.iastate.edu/it/
windows-10-functions

Tiwari, R. (2017). Keyboard shortcuts and system commands for popular programs 
[Web page]. Retrieved from https://turbofuture.com/computers/keyboard-shortcut-
keys

Pyidaungsu Font. (n.d.). Retrieved from http://mcf.org.mm/download-center/
pyidaungsu-font.html
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3.2.

How to use Microsoft Word. (n.d.). Retrieved from https://www.digitalunite.com/
technology-guides/creating-documents/how-use-microsoft-word

A beginner’s guide to Microsoft Office. (n.d.). Retrieved from https://www.investintech.
com/resources/articles/beginnersmsoffice/

UNESCO. (2018). Basic ICT training manual. Yangon, Myanmar: UNESCO

Microsoft Word – Basic & Advanced. (n.d.). Retrieved from https://www.goskills.com/
Course/Microsoft-Word

Word Basics. (n.d.). Retrieved from https://edu.gcfglobal.org/en/word2010/
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Myanmar Fonts (Alpha Zawgyi, Myanmar2, Myanmar3) [Blog]. (n.d.).  https://
myanmaritacademy.blogspot.com/2013/08/myanmar-fonts-alpha-zawgyimyanmar2.
html

Myanmar Unicode Download – Free Alpha Zawgyi [Blog]. (n.d.). https://alpha-zawgyi-
download.blogspot.com/
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Expected learning outcomes

By the end of this unit, you will be able to:

• Explain what Media and Information Literacy is and why it is important for a
teacher (including but not limited to teaching) in primary school;

• Understand the difference between types of information providers and types of
media; and

• Understand the functions of the different media and information providers and the
role they play in a democratic society.

Media and 
Information 
Literacy and Digital 
Citizenship1

Unit
4

In this unit, you will be introduced to the principles and basic concepts of Media and 
Information Literacy. You will learn the competencies that a Media and Information 
Literate person should have and why it is important that teachers and students are 
Media and Information Literate. The unit will take you through the different media and 
information providers and the functions and roles that they play in a democratic society.

1 During Semester 1, 4.1.1 Understanding the principles of Media and Information Literacy and 4.1.2 The roles and functions of 
Media and Information providers will be covered. This unit will further be covered during Semester 2. 
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This sub-unit is divided in three different lessons. Lesson 4.1.1. provides a general overview 
of what is Media and Information Literacy, and the importance of it when teaching and 
learning about and through ICTs. Lesson 4.1.2. aims at explaining the different roles that 
the media and the information providers play in our society. Lesson 4.1.3. is devoted to 
one specific type of media, News Media, and its importance in democratic societies.

By the end of the lesson, you will be able to:

• 	 Explain what Media and Information Literacy is and why it is important for a 
teacher (including but not limited to teaching) in primary school.

Expected learning outcomes

4.1.1.
Understanding the principles of Media and 
Information Literacy

4.1. Media and 

Information Literacy
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Why do we need Media and Information Literacy? 

In the 21st century, the exposure and the multi-media content that the public has to 
access and information is not only due to the growing number of information providers 
but also due to media platforms. The evolution of ICTs such as smartphones and the 
rapid expansion of internet access globally are affecting the ways in which media and 
information are consumed and shared.

The society in which we live today is driven by information and knowledge. The decisions 
we make every day, what we know about what is currently happening in our country or 
what we know about other countries and different cultures around the world, are based 
on the information that we access and receive everyday through internet, newspapers, 
television, radio, movies and books.

A new form of literacy affecting our lives

Traditional literacy, understood as the ability to learn reading, writing and numeracy, is 
no longer sufficient to participate and succeed throughout all stages of life. The growth of 
information providers and media, the rapid development of ICTs and the bigger presence 
they have in our daily activities, play a determinant role in our personal, social, economic 
and political lives.

Media and information affect our personal and social life in many ways. A simple example 
is that we buy our clothes, and we change our style based on the newest trends in fashion 
that we see on TV and movies. To a great extent, we also learn gender roles influenced by 
how men and women are portrayed in magazines, TV series or films.

As for the economic life, we might decide when to request a loan from the bank or make an 
investment based on the news we read on how the economy in our country is performing.
When it comes to political life, we might decide which political party or which politician 
we are going to vote in the next elections based on what we learn about them through 
the news published in the newspapers or TV; or we build an opinion around certain 
government programme based on the news we read or watch.
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The amount of information and media content that is being created, shared and consumed 
every day is greater than ever before. Therefore, it is important to acquire a new set of 
competencies (knowledge, skills and attitudes) that allow citizens to consume, share and 
produce information in a critical and effective way. This is why Media and Information 
Literacy (MIL) is important to teaching and learning processes.

Basic principles and notions of Media and Information Literacy

MIL is defined as a set of competencies that empower citizens to access, retrieve, 
understand, evaluate and use, create as well as share information and media content in all 
formats, using various tools, in a critical, ethical and effective way in order to participate 
and engage in personal, professional and societal activities. (UNESCO, Global Media 
and Information Literacy Assessment Framework: Country Readiness and Competencies, 
2013).

It is important to note that MIL is a combination of two concepts, Information Literacy 
and Media Literacy, and each concept refers to a specific set of knowledge, attitudes and 
skills.

Information Literacy puts the focus on accessing information, evaluation and ethical use 
of that information. Media Literacy refers to the ability to understand the functions and 
roles that media play in society, evaluate the performance of those functions and, based 
on that, engage with media in a critical way for the purpose of self-expression. 

In the chart below, you can see the different components of each type of literacy:

Figure 4.1. Components of information literacy and media literacy

For information literacy:

Define and 
articulate 

information 
needs

Organise 
information

Locate 
and access 
information

Make ethical 
use of 

information

Assess 
information

Communicate 
information

Use ICT skills 
for informtion 

processing

For media literacy:

Understand the role 
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media in democratic 
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Understand the 
conditions under 
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their functions

Critically evaluate 
media content in 
the light of media 

functions

Engage with media 
for self-expression 

and democratic 
participation

Review skills 
(including ICTs) 

needed to produce 
user-generated 

content
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The combination of both concepts, Media and Information Literacy, includes three 
different processes:

	 1.	 Accessing information and media content: The first step in MIL refers to the ability  
		  to search, access and retrieve information and media content. To access the  
		  information needed for day-to-day decision making, problem solving, participation  
		  in society and learning, it is indispensable to be able to articulate what is the specific  
		  information needed. Based on those information needs, it will be possible to locate  
		  and access effectively relevant information, and discard the content that is  
		  irrelevant or/and inadequate;

	 2.	 Evaluation of information and media content: The second step refers to the ability  
		  to understand, critically evaluate and analyse the information that has been accessed  
		  and retrieved. The information is evaluated based on its credibility (is this  
		  information credible? Real?), authority (does it come from a credible source) and  
		  purpose (what is this information or media content needed for?). Finally, the  
		  content that has been accessed and evaluated, is ready to be used or applied; and

	 3.	 Production, sharing and use of media content and information: The last step in  
		  MIL is about producing information and media content and sharing it with others  
		  for educational purposes, self-expression and/or democratic participation. This  
		  last step in MIL includes in one hand the necessary ICT skills to process information  
		  (photography, recording, video and audio editing, and so on) to produce content and  
		  on the other hand, the ability to communicate the user-generated content in an  
		  ethical and responsible way in the format and medium that is most appropriate for  
		  the intended audience.

The three processes are interrelated with one another and each of them requires distinct 
skills and knowledge. In order to engage with media and use information providers such 
as libraries, archives, and so on, it is essential to understand what their functions are, 
what their purpose is and what role they play in our society in the light of Freedom of 
Expression and Right to Information.
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Nowadays, a vast majority of media content, including newspapers or TV/radio content 
is consumed through ICTs (such as smartphones, tablets or laptops). In some contexts, 
Digital Literacy or ICT Literacy is also included under the umbrella concept of Media and 
Information Literacy.

Why teachers need to be Media and Information Literate

Teachers often use different information and media texts in the classroom to better present 
or/and illustrate concepts, ideas and events and support the learning process of students. 
Therefore, teachers must understand how media and information might be utilised in 
the school curriculum. Teachers have to be able to critically assess media content and 
information sources in the light of the functions attributed to news media and other 
information providers. This will allow them to select the most appropriate materials from 
media and information resources to be used in the classroom.

To maximise the existing information and media content for its use in the classroom, 
MIL provides teachers with enhanced knowledge of the whole range of media and other 
information providers that are available to them, from libraries and print newspapers to 
the newest social media platforms or the internet.

Media and Information Literate teachers will lead to Media and Information Literate 
students. Critical thinking and problem-solving skills acquired by teachers through MIL 
will be effectively transferred to students across the different subjects in the curriculum. 
If teachers know and understand the core concepts, tools of enquiry and structures of 
MIL, they will be able to create learning experiences that are meaningful for students and 
prepare them for their role as citizens.

With the application of media and information resources, MIL also enables teachers’ life-
long learning and professional development. MIL provides teachers with the necessary 
skills to use media and technology to locate and access information, resources and tools 
that will support them in acquiring new subject matter and pedagogical knowledge in 
support of their own professional development.
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Learning activity 1

Think about how often and for which purpose you engage with information providers and 
the media in your day-to-day life.

In the table below,

1. List the types of media or/and information providers that you engaged with during
the last week;

2. Estimate the overall time that you spent interacting with them during the last
week; and

3. Describe the reason(s) why you interacted or accessed those types of media and/
or information providers.

Type of Media or Information 
Provider

Number of hours spent 
in one week Purpose for interaction
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Learning activity 2

In groups, choose a topic about something that has recently happened in your township or 
city. It can be a festival, an event organised by the government or the community, and so 
on. you can get inspiration from the news.

You are planning to gather information and process it to present and explain that event to 
your class. For that purpose, answer the following questions:

1. Why do I need that information?

2. Where am I going to search for that information/media content?

3. How do I retrieve and store the information/media content?
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			   Learning activity 3

Now, you know the basic principles of MIL which strengthen the ability to access, 
evaluate and produce information and media content. Explain in your own words why MIL 
is important for you when you become a primary school teacher after graduation. Your 
explanation should be between half page and one page long.

	 5.	 How shall I apply the new knowledge?

	 6. 	 What media shall I use to communicate the information/knowledge/media content?

	 4.	 How do I know if the information/media content I collected and retrieved is of 
good quality, accurate and truthful?
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By the end of the lesson, you will be able to:

• 	 Understand the difference between types of information providers and types of 
media; and

•	 Understand the functions of the different media and information providers and 
the role they play in a democratic society.

Expected learning outcomes

4.1.2.
The roles and functions of Media and 
Information providers

What are the media and what are their functions?

Information is anything that informs. It can be defined as data, facts, experiences 
or knowledge that has been processed to be presented in a way that can be used and 
applied for a certain purpose. The media are one way through which the information and 
knowledge is communicated to the public.

Media has evolved through the years. Media was born with the development of written 
languages. The possibility or recording information in written form, allowed humanity to 
communicate information and knowledge. With time, it evolved into print media (books, 
newspapers, magazines, and so on.) thanks to the revolutionary invention of the printing 
press in 1439 by Johannes Gutenberg. The evolution of the media happened hand in hand 
with the development of technologies. In the 20th century new technological advancements 
allowed recording sound and image, and new media forms appeared: Cinema, Television 
and Radio.

Media can also be defined by the format in which the information is packaged and 
communicated: Print Media (newspapers, books, magazines, comic books), Audiovisual 
Media (movies, photographs, radio, audio recordings) and Digital Media (blogs, social 
media like facebook or youtube, videogames). Nevertheless, it is important to note that 
many media can contain other types of media texts. For example, we can find photos in a 
newspaper or we can watch videos or listen to audios on social media, and so on.
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It is important to note that in this lesson we talk about media and information providers 
because media are just one way to communicate information and knowledge. There 
are also other non-media information providers where the public can access and search 
information from, such as libraries, archives, museums or the internet.

General roles of the media and information providers

To be able to access, evaluate and use/produce/share information and media content, it 
is critical that the public understand the different roles that the media and information 
providers play. The general roles that the media and information providers play are listed 
below:

	 •	 Inform;
	 •	 Educate;
	 •	 Facilitate teaching and learning processes;
	 •	 Provide access to all types of information;
	 •	 Promote universal values and civil rights, such as freedom of expression and  
		  information;
	 •	 Serve as society’s collective memory;
	 •	 Gather information;
	 •	 Preserve cultural heritage; and
	 •	 Entertain.

As part of MIL, we pay special attention to one specific type of media, News Media. For 
the purpose of this subject, the news media is defined as sources of credible and current 
information created through an editorial process determined by journalistic values. 
These media play several roles beyond just communicating information and knowledge.

It is important to note, that one media can play more than one role from the list above. For 
example, a TV documentary about wildlife can Inform, Educate and can also Entertain. 
On the other hand, we can also find the media which only fulfill one role. For example, a 
comedy film only seeks to Entertain the audiences.
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			   Learning activity 1

Think about what practices you usually do that makes you a Media and Information Literate 
person by answering the following questions.

	 1.	 Do you double-check with other media the news you read in facebook?
	 2.	 Do you check different information sources to ensure the quality of the information  

	 you have located before using it?
	 3.	 Do you share information (posts in facebook, a message received through viber, an  

	 article or video found online) before verifying it is true or false?

The roles of news media include the following:

	 •	 Act as channels of information and knowledge through which citizens communicate  
		  with each other and make informed decisions;
	 •	 Facilitate informed debate between diverse social actors;
	 •	 Provide us with much of what we learn about the world beyond our immediate  
		  experience;
	 •	 Are means by which a society learns about itself and builds a sense of community;
	 •	 Function as a watchdog of the government in all its forms, promoting transparency  
		  and public scrutiny of those with power through exposing corruption,  
		  maladministration and corporate wrong-doing;
	 •	 Are essential facilitators of democratic processes and one of the guarantors of free  
		  and fair elections;
	 •	 Are a vehicle for cultural expression and cultural cohesion within and between  
		  nations; and
	 •	 Function as an advocate and social actor in its own right while respecting pluralistic  
		  values.

The growth of media and especially the rapid expansion of the internet has extremely 
widened the information and media material, content and resources available. The 
reliability, accuracy and value of that information, can range from very good quality to 
very bad quality, or even harmful. It is, therefore, important that the people understand the 
roles of information providers and the media, so that they can effectively engage with the 
media and search, access, evaluate and use the information they need.
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Learning activity 2

In each of the examples provided below, identify which role or roles is the news media 
playing in each case. Note that some of the examples can fulfill more than one role of the 
media.

A. An investigative report published in a daily newspaper about a Minister that has
been giving multi-million contracts to companies owned by members of his family.

B. A foreign company will be building a production plant in the bank of the
Ayeyarwaddy river, near a village where most of the population are farmers and
fisherfolk. In the news, they have interviewed the owners of the plant who talk
about the new jobs that they will create when they build the plant. Local farmers
have been also talking on TV, complaining that the waste produced by the plant will
pollute the water and the soil, and no vegetables will grow there anymore, making it

Learning activity 2

Work in groups to search online two to three resources or media content that are examples 
of the functions listed below. Please note that one example/media/information provider 
might fulfill more than one role.

1. Inform
2. Educate
3. Facilitate teaching and learning processes
4. Provide access to all types of information
5. Promote universal values and civil rights, such as freedom of expression and

information
6. Serve as society’s collective memory
7. Gather information
8. Preserve cultural heritage
9. Entertain
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Roles and functions of the news media:

1. Act as channels of information and knowledge through which citizens communicate
with each other and make informed decisions.

2. Facilitate informed debated between diverse social actors.

3. Provide us with much of what we learn about the world beyond our immediate
experience.

4. Are means by which a society learns about itself and builds a sense of community.

5. Function as a watchdog of government in all its forms, promoting transparency and
public scrutiny of those with power through exposing corruption, maladministration
and corporate wrong-doing.

impossible for them to live from farming. The protests staged by environmentalists 
have been also covered by the news, they claim that the pollution of the plant will 
destroy the ecosystem of the region. In a press conference, the government assures 
the local population that the plant will not affect their  livelihoods and will bring 
great wealth to the region.

C. In the lead up to the general elections, a TV channel will be broadcasting a debate
between the Chairs of the two main political parties. In the TV programme, both
leaders will present their electoral programmes. In the elections day, journalists
and TV crews will be at the poll stations to report any incidents that might happen
during the election day, and make sure that the guidelines issued by the Election
Commission are strictly followed.

D. A TV documentary series about the culture and customs of the different ethnic
groups that co-exist in Myanmar.

E. A feature story in a newspaper that denounces the high number of incidents of
gender-based violence that rural women suffer and the lack of policies and
mechanisms to address the issue.
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Review questions

1. Reflect on what you have learnt in the lessons under this unit, and assess your
understanding of the subject.

2. Media and Information Literacy is important for a teacher in primary school. Please
give examples why it is important.

3. What are the differences between types of information providers and types of media?

4. What are the roles media and information providers play in Myanmar?

Yes No Not sure

Lesson 4.1.1.

I can explain what Media and Information Literacy is and why it is 
important for a teacher (including but not limited to teaching) in primary 
school.
Lesson 4.1.2. 

I understand the difference between types of information providers and 
types of media.

I understand the functions of the different media and information 
providers and the role they play in a democracy.

6. Are essential facilitators of democratic processes and one of the guarantors of free
and fair elections.

7. Are a vehicle for cultural expression and cultural cohesion within and between
nations.

8. Function as an advocate and social actor in its own right while respecting pluralistic
values.
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Further reading

4.1. 

UNESCO. MIL Curriculum For Teachers (English). http://unesdoc.unesco.org/
images/0019/001929/192971e.pdf

UNESCO. MIL Curriculum For Teachers (Myanmar). http://unesdoc.unesco.org/
images/0019/001929/192971MYA.pdf

UNESCO. Media and Information Literacy: Policy and Strategy Guidelines
(English). http://unesdoc.unesco.org/images/0022/002256/225606e.pdf

Phandeeyar. Internet Bawdar. https://www.internetbawdar.com/
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Glossary

Terms Elaborations

Arithmetic Logic Unit
(ALU)

The part within a Central Processing Unit which carries 
out arithmetic operations like addition, subtraction, 
multiplication and division and other logical actions such 
as AND and OR functions and operates on data available 
in the main memory and send them back after processing

Artificial Intelligence (AI) A computer system that stimulates human intelligence 
process which include learning, reasoning and interacting.

Asynchronous Something not occurring at the same time or delay between 
two or more points. For example, in asynchronous 
conferencing, there is a delay in interaction between 
participants.

CD-ROM An adaptation of the CD that is designed to store computer 
data in the form of data( text, graphics and so on). Its full 
name is Compact Disc, read-only-memory.

Central Processing Unit 
(CPU)

The main part of a computer in which all processing is 
carried out and which controls the activities of the whole 
computer configuration

Control Unit The part which directs all operations inside a computer 
and can be known as the heart of the computer because it 
controls and coordinates all hardware operations including 
the Central Processing Unit, input and output devices

Conferencing Two or more peoples have simultaneous conversation 
using Internet, it is called conferencing. When this process 
is adding video streaming technology, it is called video 
conferencing.

Copyright A set of rights granted to the author or creator of a work to 
restrict others’ ability to copy, redistribute and reshape the 
content. Rights are frequently owned by the companies 
who sponsor the work rather than the creators themselves, 
and can be bought and sold on the market. 
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Terms Elaborations

Democracy A system of government where the people have final 
authority which they exercise directly or indirectly through 
their elected agents chosen in a free electoral system. It 
also implies freedom to exercise choice over 
decisions affecting the life of the individual and the 
protection of fundamental rights and freedoms. In 
this context, independent media and free access to 
information are fundamental to the pursuit of 
democracy and freedom in the whole world.

Digital The electronic technology using two electronic states: ON 
and OFF expressed in Digits (ON = 1 and OFF = 0), to 
generate, store and process data. In computer system, the 
information is stored in the form of a string of 0s and 1s, 
and each digit is referred to as a bit.

DVD A digital optical disc storage format which can store 
computer data with higher capacity than a compact disc 
(CD), while having the same dimensions. 

File The digital version of resource or data stored in computer 
system.

Flash drive A data storage device which is also called thumb drive, 
pen drive or flash stick. It is typically removable, rewritable 
and much smaller than an optical disk.

Folder The cataloging structure of a directory in a file system 
which can put files inside. 

Freedom of Expression A fundamental human right. It is used to indicate not only 
the freedom of verbal speech but any act of seeking, 
receiving and delivering information.

Graphical User Interface
(GUI)

A feature which allows users to interact with the system 
and applications through graphical icons instead of text-
based user interfaces.

Hard Disk Drive (HDD) An electromechanical data storage device which use 
magnetic storage technology to store and retrieve digital 
information. 
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Terms Elaborations

Information Literacy Focuses on the purposes of engaging with information 
and the process of becoming informed. It is associated 
with the concepts of learning and making decisions 
through its emphasis on defining needs and problems, 
relevant information and using it critically and responsibly 
(ethically).

Input device Any device that enters information into a computer from 
an external source

Internet The most well-known and the largest network linking 
hundreds of thousands of individual smaller networks all 
over the world. 

Joystick A cursor control device used in computer games and 
assistive technology, being a hand-held lever that pivots 
on one end and transmits its coordinates to a computer

Local Area Network 
(LAN)

A network of computers that interconnect within a limited 
area.

Media Physical objects used to communicate, or mass 
communication through physical objects such as radio, 
television, computers, films, etc. It also refers to a physical 
object used to communicate media messages. Media are a 
source of credible information in which contents are 
provided through an editorial process determined by 
journalistic values and therefore, editorial accountability 
can be attributed to an organisation or person. In more 
recent years, the term media is often used to include new 
online media. Media are channels of information and 
education through which citizens can communicate with 
each other and disseminate stories, ideas and information, 
they are also vehicles for cultural expression and cultural 
cohesion within and between nations. 

Media Literacy The ability to read, analyze, evaluate and produce 
communication in a variety of media forms (e.g. television, 
print, radio, computers, etc.)

Memory The part in a computer to store information which can be 
recalled and accessed when required
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Terms Elaborations

Metropolitan Area Network 
(MAN)

A network that interconnect computer resources in a 
geographic area or region larger than that covered by 
LAN.

Modem A conversion device which converts signals from one 
device into signals another device can read. Its full name 
is modulator demodulator. For example, a modem may 
covert the digital data of a computer into an analog signal 
that can be read and carried by a telephone line.

Operating System The system software which operate hardware and act as 
the platform for end-users’ application software.

Optical character 
recognition

A device which reads printed or written text characters 
and then translates the character image into commonly 
used character codes for data processing.

Output device Any device that translates the computer output into a form 
that human beings can understand.

Processing device Any electronic devices that process or transform provided 
information as an input to output.

Right to information The right of citizens to access information held by public 
bodies (Government, parliament, military, etc.)

Solid-state Storage Drive 
(SSD)

A data storage device which uses integrated circuit 
assemblies as memory to store data persistently. SSDs 
are more resistant to physical shock, lower latency, faster 
access time but more expensive than HHDs.

Voice recognition A device which enables the translation of spoken 
language into text

Wide Area Network (WAN) The computer network which is also called 
telecommunications network. The Internet may be 
considered a WAN.
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UNESCO Basic ICT literacy Training Manual

Youth Protection Roundtable Toolkit – Stiftung Digitale Chancen, 2009 https://www.
digitale-chancen.de/transfer/assets/final_YPRT_Toolkit.pdf

UNESCO. E-learning Series on ICT in Education. http://archive1.unescobkk.org/file-
admin/user_upload/ict/Teacher_Training_Workshops/UNESCObkkE-LearningSeri-
seOnICTInEducation.zip

Types of input devices with explanations: https://www.tutorialspoint.com/computer_
fundamentals/computer_input_devices.htm

 
Types of output devices with explanations: https://www.computerhope.com/jargon/o/

outputde.htm

 
The Evolution of Computers: https://www.nortonsecurityonline.com/security-center/

evolution-of-computers.html

Biblography

Year 1 Semester 1 - EDU1109 - Curriculum and Pedagogy Studies: Information and Communication Technology



Year 1 Semester 1 - EDU1109 - Curriculum and Pedagogy Studies: Information and Communication Technology

Student Teacher Textbook 133

 Data Transfer Rate: https://searchunifiedcommunications.techtarget.com/definition/da-
ta-transfer-rate

 
Size / Bandwidth Calculator: http://www.stardot.com/bandwidth-and-storage-calculator

 
Basic Functions of an Operating System: https://www.techwalla.com/articles/

what-are-system-interrupts

 
Different types of computers: http://www.vidyagyaan.com/computer-knowledge/differ-

ent-types-of-computer/

 
Basic ICT Literacy Training Manual: Developed by UNESCO, is available in E-Library.

Windows Basics. (n.d.). https://edu.gcfglobal.org/en/windowsbasics/
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Windows 10 Functions. (n.d.). Retrieved from https://www.extension.iastate.edu/it/win-
dows-10-functions

Tiwari, R. (2017). Keyboard shortcuts and system commands for popular programs 
[Web page]. Retrieved from https://turbofuture.com/computers/keyboard-short-
cut-keys

Pyidaungsu Font. (n.d.). Retrieved from http://mcf.org.mm/download-center/py-
idaungsu-font.html

UNESCO. (2018). Basic ICT training manual. Yangon, Myanmar: UNESCO How to 
use Microsoft Word. (n.d.). Retrieved from https://www.digitalunite.com/technolo-
gy-guides/creating-documents/how-use-microsoft-word

A beginner’s guide to Microsoft Office. (n.d.). Retrieved from https://www.investintech.
com/resources/articles/beginnersmsoffice/
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 Microsoft Word – Basic & Advanced. (n.d.). Retrieved from https://www.goskills.com/
Course/Microsoft-Word

Word Basics. (n.d.). Retrieved from https://edu.gcfglobal.org/en/word2010/

Myanmar Fonts (Alpha Zawgyi, Myanmar2, Myanmar3) [Blog]. (n.d.).  https://myan-
maritacademy.blogspot.com/2013/08/myanmar-fonts-alpha-zawgyimyanmar2.html

Myanmar Unicode Download – Free Alpha Zawgyi [Blog]. (n.d.). https://alpha-zaw-
gyi-download.blogspot.com/

UNESCO. MIL Curriculum For Teachers (English). http://unesdoc.unesco.org/imag-
es/0019/001929/192971e.pdf
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UNESCO. MIL Curriculum For Teachers (Myanmar). http://unesdoc.unesco.org/imag-
es/0019/001929/192971MYA.pdf

 
UNESCO. Media and Information Literacy: Policy and Strategy Guidelines
(English). http://unesdoc.unesco.org/images/0022/002256/225606e.pdf

Phandeeyar. Internet Bawdar. https://www.internetbawdar.com/
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